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التعرف على واجهة البرنامج:الفصل الاول 

 الاولى:الوحدة التدريبيه.

التعرف على واجهة البرنامج:الموضوع.

النظرة الشاملة:

.طلاب المرحلة الاولى :الفئة المستهدفة-أ

المجالات الرسم الهندس ي هو اللغة العالمية التي يعرفها جميع العاملين في:مبررات الوحدة-ب
والرسم الهندس ي بواسطة الحاسوب من اهم وسائل التقدم التكنولوجي, الهندسية 

.لانجازمن البرامج المتقدمة في عملية الرسم لسهولته ودقته وسرعة اAutoCADوبرنامج

.التعرف على واجهة البرنامج وكيفية استخدامه:الفكرة المركزية-ج

:سيكون الطالب قادرا على:اهداف الوحدة-د

.التعرف على البرنامج1.

.التعرف على اجزاء الواجهة ومهامها2.

.كيفية اظهار الاشرطة المخفية3.

.تحديد ابعاد الشاشة4.
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الامتحان القبلي

:فيAutoCADيستخدم برنامج,اختر الاجابة الصحيحة2)

.الاحصاء-أ

.الحسابات-ب

.الرسم-ج
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الموضوع3)

 ان كلمةAutoCADتعني ان البرنامج من تصميم شركةAutodesk وهوبرنامج لتصميم
ويمتاز هذا البرنامج Computer Aided Draftingالرسم وانجازه بمساعدةالحاسبة

نجاز المطلوب بسهولة التنفيذ والدقة العالية في الرسم واختصار الوقت وتوفيراكثر من طريقة لا 
.احيانا

يمكن فتح البرنامج اما من:

النقر المزدوج على ايقونة البرنامج الموجودة على سطح المكتب-أ

:وذلك , علما ان البرنامج باللغة الانجليزية فقط all programثم النقرعلى startعن طريق-ب

Start → all program → Microsoft office → Microsoft PowerPoint        
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:وتحتوي واجهة البرنامج على

ويحتوي على الملف قيد العمل:address barشريط العنوان1.

:قائمة وهي12ويحتوي على :menu barشريط القوائم المنسدلة2.

▪File: لانشاء ملف جديد اوفتح ملف سابق اوحفظه اوطباعته أو المعاينة.

▪Edit:وتحتوي على اوامر القص واللصق وغيرها.

▪View:وتحتوي على ادوات الرؤية والعرض.

▪Insert: لادراج رسوم اوملفات من نفس البرنامج اومن برامج اخرى.

▪Format: وتتحكم باللون والطبقات والانماط.

▪Tools: وتحتوي على بعض الاوامر المساعدة للرسم.

▪Draw: وتحتوي على معظم العناصر الرئيسية لرسمها.

▪Dimensions: وتحتوي على الاوامر الخاصة بالابعاد.

▪Modify:وتحتوي على اوامر التعديل

▪Help: وتحتوي على التعليمات المساعدة للتنفيذ.

▪Window+Image.
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اشرطة الادوات الظاهرة والمختفية

ة شاشة وتحتوي على عدد كبيرمن اشرطة الرموز الخاصة بالاوامرقد تكون ظاهرةفوق مساح:اشرطة الادوات3.
:الرسم اوعلى احد جانبيها وقد يكون الشريط مختفي ولاظهاره نستخدم احد الطرق التالية

فتظهر Customizeاوعلى خيار ACADالنقر باليمين في مكان فارغ خارج شاشة الرسم والنقرعلى خيار❖
يظهر على قائمة اشرطة الرموز فيتم اختيارالشريط حسب الحاجة الانية بالنقرعليه اوفي المربع امامه ف

.شاشة الرسم ويمكن وضعه في مكان مناسب ويمكن اخفائه في أي وقت

❖Tools→Customize→Toolbars

❖View→Toolbars→Customize

.النقرباليمين على أي رمز ظاهر على الشاشة من اشرطة الرموز ❖

.ويمكن اختيارابعادها حسب الحاجةواختيارلونها وتكون سوداء عادة:شاشة الرسم 4.

.حيث يمكن الكتابة لتنفيذ الاوامر:Commandشريط الاوامر5.

وهو اسفل الشاشة ويحتوي على عدة ايعازات تساعد على الرسم :Status barشريط الحالة6.
.Snap,Grid,Ortho,Polar,Osnap,Otrack,LWT,Modelبدقةمثل
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oمج؟كم عدد القوائم المنسدلة في واجهة البرنا

18-أ

15-ب

10-ج

12-د
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]ابعاد شاشة الرسم[تحديد مساحة الرسم •

شة عن ويمكن التحكم بابعاد الشا,يجب ان تكون ابعاد شاشة الرسم متوافقة مع مساحة اللوحة المطلوب رسمها

:بتنفيذ الخطوات التاليةFormatطريق القائمة 

.1Format→Drawing limits

<Specify lower left corner or[ ON/OFF]<0.0000,0.0000تظهر الرسالة التالية2.

0,0للموافقة على القيمة الافتراضية وهيEnterحيث تطلب تحديد الركن اسفل اليسار ننقر على مفتاح 

حيث توجد القيمة التي تحدد ابعاد :<  >Specify upper right cornerتظهر الرسالة الثانية 3.
قيمة في حالة الموافقة على القيمة المكتوبة اوكتابة الEnterشاشة الرسم بين القوسين فأما ننقر على مفتاح 

.Enterالمناسبة ثم النقر على مفتاح 

.Enterفي شريط الاوامر ثم نضغط على مفتاح Zنكتب 4.

.Enterفي شريط الاوامر ثم نضغط على مفتاح Aنكتب5.

.وذلك لتثبيت الخيار الذي تمت الموافقة عليه في الخطوة الثالثة
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AutoCADطرق تحديد النقاط وكيف يتم الخروج من اوامر 

 يحدد مكان النقاط على شاشة الرسم بواسطة:طرق تحديد النقاط على شاشة الرسم

.النقربالماوس -أ

.لوحة المفاتيح بكتابة إحداثيات النقطة-ب

 الخروج من اوامرAutoCAD, ويتم بأحد الخيارات التالية:

.في لوحة المفاتيحENTERالنقر على مفتاح -أ

.في لوحة المفاتيح Escالنقر على مفتاح-ب

.ENTERالنقر على يمين الماوس واختيارامر -ج
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ماهي القائمة التي تستخدم لتنفيذ رسم عنصر:1س:

.Drawقائمة -أ

.Helpقائمة -ب

.Viewقائمة -ت

.Toolsقائمة -ث

ماهي القائمة الرئيسية التي تستخدم للتعديل في الرسم :2س:

.Dimensionقائمة -أ

.Modifyقائمة -ب

.Drawقائمة -ج

.Insertقائمة -د
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كيف يتم احضار شريط مخفي ؟

.النقر باليمين على أي رمز ظاهر على الشاشة -أ

.النقر باليسار على أي رمز ظاهر على الشاشة -ب

.Drawبالنقر على قائمة الرسم -ج

.بالنقر على أي مكان على الشاشة -د

يتم اختيار ابعاد جديدة مناسبة لنافذة الرسم عن طريق:

.Dimensionقائمة -أ

.Drawقائمة -ب

.Formatفي قائمة Drawing limitsخيار -ج
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لتثبيت اختيار الابعاد الجديدة لنافذة الرسم يجب اجراء الخطوة التالية:5س:

.مرتين باليسارenterننقر على مفتاح -أ

.باليمين enterننقر على مفتاح -ب

.enterفي شريط الاوامرثم ننقرعلى مفتاح Zنكتب -ج

.enterفي شريط الاوامرثم ننقر على مفتاح Aثم نكتب enterفي شريط الاوامر ثم ننقر على مفتاح Zنكتب -د
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الاجابات

ج:ج:سيالاختبار القبل

د:  جسالاختبار الذاتي

1سيالاختبار البعد

2س

3س

4س

5س

أ:  ج

ب

أ

ج

د
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رسم بعض العناصر الرئيسية:الفصل الثاني

النظرة الشاملة:

.طلاب الصف الاول :الفئة المستهدفة -أ

ان أي شكل هندس ي أو أي غير هندس ي اواي جسم مكون من عدد من العناصر         :مبررات الوحدة ب-

ب كيف ولرسم الشكل يجب ان يعرف الطال, الهندسية الاساسية مثل الخط والدائرة والمستطيل وغيرها 
.يرسم العناصر الاساسية أولا 

.رسم العناصر الاساسية وبطرق مختلفة :الفكرة المركزية -ج

:توفرة سيكون الطالب قادرا على رسم العناصرالتالية وبعدة طرق حسب المعلومات الم:اهداف الوحدة   -د

.  Polygonالمضلع -.   Circleالدائرة -.   Arcالقوس -.   Lineالخط المستقيم -

.Polylineالمتعدد -.   Ellipseالشكل البيضوي -.   Rectangleالمستطيل -

.Pointالنقطة -.   Splineالشكل المتموج -
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لرسم مستقيم يجب معرفة؟:1س

.إحداثيات نقطة البداية واحداثيات نقطة النهاية-أ

.إحداثيات نقطة البداية وطول المستقيم والزاوية-ب

.إحداثيات نقطة واحدة-ج

لرسم دائرة يجب توفر المعلومات التالية؟:2س

.إحداثيات مركز الدائرة ونصف القطر-أ

.إحداثيات مركز الدائرة والقطر-ب

.مركز الدائرة فقط -ج
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الموضوع

:ملاحظة عامة ◦
ارات وهي لرسم أي عنصر هندس ي كالخط اوالدائرة اوالمستطيل أو القوس اوغيرها هنالك ثلاث مس

:

.Drawعن طريق قائمة 1)

.وذلك بالنقر على رمز العنصر المطلوب drawعن طريق شريط رموز الرسم 2)

(.انيغالبا بكتابة الحرف الاول اوالحرفين الاول والث)عن طريق كتابة اسم الرمز أو اختصاره3)
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Lineرسم المستقيم -

:هنالك ثلاث طرق لرسم الخط المستقيم وهي 

.x,y:طريقة الاحداثيات الديكارتية المطلقة1)

.@L,0:طريقة الاحداثيات النسبية 2)

.@L < A:طريقة الاحداثيات القطبية3)

( .100,0) و( 0,0)ارسم الخط المستقيم بين النقطتين : مثال

.بعد كتابة كل خطوة  Enterيجب النقر على مفتاح : طريقة الاحداثيات المطلقة 1)

Command: L  

Specify the first point :0,0                                                             

Specify next point or[Undo]:100,0                         

Enter or Esc                                
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:ملاحظات

. tools→New UCS→Origin→(0,0)وذلك من قائمة0,0يفضل تثبيت نقطة الأصل في 1)

.       Tools→Move UCSيمكن تغيير مكان نقطة الأصل وذلك بكتابة إحداثيات اخرى أو 2)

.مرة واحدةEnterبعد الانتهاء من كتابة أي سطر في هذا البرنامج لابد من النقر على مفتاح 3)

ة الى امر كما يمكن العود,يمكن رسم مستقيم اخرفي أي مكان على شاشة الرسم  بتكرارالخطوات السابقة4)

لى ثم متابعة تنفيذ الخطوات اللاحقة وهذا يعني انه يمكن العودة اEnterرسم المستقيم بالنقرعلى مفتاح 
وامرهذا تنفيذ أي امر سابق مباشرة أي ان هذه الخطوة لاتختص برسم المستقيم فقط بل تشمل جميع ا

.البرنامج 

.تعني التراجع عن تنفيذ الخطوة السابقة أي الغائها[Undo]كلمة 5)

في لوحة المفاتيح لافرق EscاوEnterللخروج من الامرعندما ينتهي تنفيذه يمكن بالنقر على أي من مفتاحي 6)
.بينهما

ويمثل اختيار لطريقة التنفيذ أو خطوة محددة أو [  ]في اغلب الخطوات هنالك مامكتوب ضمن الاقواس 7)
.ارج الاقواس اضافة للمواصفات وعند الحاجة لتنفيذها يجب ان تنفذ قبل تنفيذها اولا قبل تنفيذ الامر خ
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:ة حل المثال السابق بطريقتي الاحداثيات النسبية والقطبي

:بواسطة الاحداثيات النسبية ❖

Command : L                                                                   

Specify the first point : 0,0                                               

Specify next point or [Undo] : @ 100,0                           

Enter ,or Esc                                                                   

: بواسطة الاحداثيات القطبية ❖

Command : L                                                                           

Specify first point :  0,0                                                            

Specify next point or [Undo] : @ 100<0                                  

Enter ,or Esc                         

لكي يتم استلام الامر  Enterبعد اتمام كل خطوة يجب النقر على مفتاح ,نعود ونذكر 
                                                         .
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ارسم الشكل بالطرق الثلاثة؟: س 

:الحل 

o طريقة الاحداثيات المطلقة:

Command : L                                       

Specify first point :100,100                  

Specify next point or [Undo] :400,100 

Specify next point or [Undo] :400,250 

Enter                                                   

o طريقة الاحداثيات النسبية:

Command : L                                      

Specify first point : 100,100                

Specify next point or [Undo] :@300,0 

Specify next point or [Undo] :@0,150 

Enter                                                   
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حل السؤال–تتمة 

o طريقة الاحداثيات القطبية:

Command : l                                        

Specify first point : 100,100                 

Specify next point or [Undo] :@300<0

Specify next point or[Undo]:@150<90

Esc                                                     

******************************************

:ملاحظة 

فتاح يجب النقر على م,عند الانتهاء من كتابة كل خطوة ✓

enter .

أو  enterللخروج من الامر يجب النقر على مفتاح ✓
esc  في لوحة المفاتيح لا فرق.
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Arcامرالقوس 

:لرسم قوس نتبع احد المسارات التالية 

تظهر قائمة فرعية بعشرة خيارات يستخدم أي منها لرسم قوس وذلك حسب Draw →Arcقائمة 1)
.المعلومات المتوفرة

.Drawبالنقر على رمز القوس الموجود في شريط الرموز 2)

:وفي الخيارين الثاني والثالث يسأل البرنامج اما عن,(a)اي الحرف arcبكتابة الحرف الاول من كلمة 3)

Start point→center→angle ,OR chord length ,OR end point             

End→center point ,OR angle ,OR direction , OR radius                   

               Center→start point→end point ,OR angle,OR length:أو عن

ونهايته الزاوية بين بداية القوس centerالمركزendالنهاية startنقطة بداية القوس :علما ان 
angleطول الوتر الواصل بين نقطة بداية القوس ونهايتهchord length

. directionواخيرا فان اتجاه مماس القوس في نقطة بدايته هي 

لمسار مع وان كان ا,اذا كان المسار بعد نقطة البداية باتجاه عكس عقرب الساعة تكون قيمة الزاوية موجبة :ملاحظة

.      عقرب الساعة تكون الزاوية سالبة 
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؟Line ,Arcارسم الشكل التالي بالأمرين : س 
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:الحل

ن طريق نقل نقطة الأصل الى مكان وسط شاشة الرسم ليكون الشكل في الوسط وهي خطوة غير الزامية وقد تمت ع1.

→ Tools         :Toolsالقائمة  Move UCS.

:لرسم المستقيمات 2.

Command : L                                                                                  

Specify first point : 0,150                                                              

Specify next point or [Undo ] : 0,0                                                

Specify next point or [Undo ] :100,0                                             

Specify next point or [Undo ] : 100,150                                        

Esc                                                                                                  

                                                      command : a: لرسم القوس 3.

Specify start point of arc or [Center] : 100,150                            

Specify second point of arc or [Center/End] :c                           

Specify center point of arc : 50,150                                              

Specify end point of arc or [Angle/Chord length] : 0,150           

Enter                                                                                               
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Circleامر دائرة -

رةيمكن رسم دائرة عن طريق احد الخيارات التالية تبعا للمعلومات المتوف:

.1Center,radiusأي بمعرفة إحداثيات المركز وطول نصف القطر.

.2Center,diameter بتوفر إحداثيات المركز وطول القطر.

.32pointsبوجود نقطتين تمثلان طرفي القطر.

.43points (.ة واحدةولايمكن ان تكون النقاط الثلاث على استقام)أي ثلاث نقاط تمر الدائرة بها

.5Tan,Tan,radius ونصف القطر( على الا يكونا متوازيين )بمعرفة مماسين.

.6Tan,Tan,Tanأي بوجود ثلاث مماسات.

26



لرسم مستقيم  معلوم يجب معرفة:1س:

.نقطة النهاية -أ

.نقطتي البداية والنهاية -ب

.أي نقطتين -ج

يمكن رسم قوس اذا عرفت المعلومات التالية:2س:

.بداية القوس والمركز-أ

.بوجود معلومة واحدة فقط عن القوس-ب

.بمعرفة بداية القوس ونهايته-ج

.بوجود ثلاث معلومات على الاقل -د

يمكن رسم دائرة اذاعرف:3س:

.مركز الدائرة فقط -ج.                           ثلاث نقاط على استقامة واحدة -أ

.قطر الدائرة فقط -د.                    ثلاث نقاط ليست على استقامة واحدة -ب
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:الاجابة -

1سالاختبار القبلي 

2س

ب,أ :ج 

ب,أ :ج 

1سالاختبار الذاتي 

2س

3س

ب: ج 

د: ج 

ب: ج 
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ارسم الدوائر التالية                                           : س
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.50ونصف قطرها (100,200)مركزها Aالدائرة ❑
.(200,150),(200,80),(150,75)ترسم بدلالة ثلاث نقاط Bالدائرة 

. 45ترسم بدلالة الخطين كمماسين ونصف قطر Cوالدائرة 

:Aالدائرة ❑

Command : 

c                                                                                                        

Specify center point for circle or [3p/2p/Ttr (tan tan radius)] : 

100,200                

Specify radius of circle or [Diameter] : 

50                                                            

:Bالدائرة ❑

Command : 

c                                                                                                       

Specify center point for circle or [3p/2p/ Ttr] : 

3p                                                

Specify first point on circle : 

150,75                                                                    

Specify second point on circle : 

200,80                                                              

Specify third point on circle : 

200,150                                                                 
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Polygonامر المضلع -

لرسم مضلع ما يجب ان نحدد اما:

وان يكون (center of polygon)ومركز المضلع (number of sides)عدد الاضلاع1.
(circumscribed)اوخارجها(inscribed in circle)المضلع داخل الدائرة الوهمية 

او.ونصف القطر 

.عدد الاضلاع ونقطة البداية وطول ضلع المضلع 2.
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ارسم المضلع ؟: س

في عندما يكون المضلع داخل الدائرة الوهمية وهو سداس ي ومركزه

:80ونصف قطره 300,100

(1Command : polygon                       

(2Enter number of sides<4> : 6        

(3Specify center of polygon or 

[Edge] :150,150

(4Enter an option [Inscribed in 

circle/circumscribed about circle]:

(5Specify radius of circle : 80           

.فيتم رسم المضلع كما في الشكل الاعلى 

*****************************

يكون المضلع خارج الدائرة فيستخدم الخيار  , اما عندما 

circumscribed بكتابة حرفc اعلاه 4في الخطوة
ما ان عل, اما باقي الخطوات كما هي ويكون الشكل الاسفل,

الدائرة وهمية لاتظهر في الحالتين 
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 وحدة يبدأ 100اضلاع وطول ضلعه 7ارسم مضلع ذو

؟ 100,50من النقطة 

Command : polygon                       

Enter number of sides : 7               

Specify center of polygon or [Edge] 

:e                    

Specify first end point of edge 

:100,50                      

Specify second end point of edge 

:@100,0                    

 يتم رسم الشكل المجاور,
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Rectangleامر رسم مستطيل 

الة التالية تظهر الرس,عند البدء بتنفيذ رسم مستطيل بأي من المسارات الثلاث المذكورة سابقا

:Specify first corner point 

or[chamfer/elevation/fillet/thicness/width]

لثانية ندخل إحداثيات الركن الاول وفي الخطوة ا,اذا كان المستطيل لايحتوي على أي مواصفات
(.اليمينيمثل الركن الاول الركن اسفل اليسار والركن الاخر يقصد به الركن اعلى)الركن الاخر 

 م اذا كان المستطيل يتضمن استخدام أي خيار من الخيارات الموجودة داخل القوس يجب اعلا
جب ان في,مثلا كأن تكون اضلاع المستطيل ذات عرض معين ,البرنامج قبل ادخال الركن الاول 

ثم Enterثم ننقر على مفتاح ( دلالة على اننا نريد ان ندخل قيمة لعرض الاضلاع)Wنكتب 
ل علما ان الخيارات داخ,ثم ندخل الركن الاول والآخر ,نحدد قيمة العرض في الخطوة التالية 

:القوس هي 

-Chamferقيمة القطع المستقيم في الاركان .–Fillet قيمة القطع الدائري.

-Width عرض الاضلاع    .-Elevation رسم المستطيل في مستو اخر.

-Thicknessأي ان المستطيل ثلاثي الابعاد.
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:ملاحظات 

رسم عند الانتهاء من رسم مستطيل ما يتضمن خيارات خاصة كأن تكون اضلاعه ذات عرض معين ونريد1)
ثم نكتب في الخطوة Enterثم الضغط على مفتاح  ( W)مستطيل بدون عرض يجب ان نكتب العرض 

.نتابع كتابة الركنين الاول والآخر ,أي انه تم الغاء خيار العرض( صفر)0التالية 

.الى وقت اخر ThicknessوElevationيؤجل العمل بالخيارين 2)
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ماهي خطوات رسم مستطيل ؟

. 400,200وركنه الاخر0,0ركنه الاول -1
.   10نفس المستطيل وعرض أضلاعه  -2

.20نفس المستطيل دائري الاركان  نق -3
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الحل

الحل

حل الفرع الثالث

بعد النقر عل رمز المستطيل1.

enterثم ننقر مفتاحwنكتب

0نكتب قيمة العرض 2.

enterثم ننقرfنكتب حرف3.

قيمة نق التدوير20نكتب 4.

نكتب الركنين ثم الخروج 5.

حل الفرع الثاني

ننقر على رمز المستطيل1.

enterثم ننقر wنكتب 2.

10نكتب قيمة العرض3.

الاولإحداثيات الركنينندخل4.

والثاني في خطوتين ثم نخرج من

enterالامر بنقر 

حل الفرع الاول

ننقر على رمز المستطيل1.

نكتب إحداثيات الركن الاول2.

ثم نكتب enterثم النقرعلى 

إحداثيات الركن الاخروالنقر على

Enterثم الخروج من الامر

escاوentبالنقر على 
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Pointامر النقطة -

 قبل تنفيذ امر رسم نقطة يجب اختيار شكل النقطة من قائمةFormat :

Format→point style                                     

.للموافقةOKوبعد اختيار احدها ينقر على ,يظهر مربع يحتوي على عديد من نماذج النقاط

 ترسم نقطة واحدة باستخدام خيارSingle point بينما يمكن رسم أي عدد من النقاط باستخدام

. Multiple pointخيار 

م يستفاد من امر النقطة لتقسيم أي مستقيم لعدد من القطع المتساوية الطول باستخدا

divideخيار

ثم كتابة measureأوالطول القطعة بغض النظر عن عددها باستخدام خيار , ثم كتابة عدد القطع 

.العدد 

38



قسّم مستقيم الى خمسة اجزاء ؟-أ

؟30قسّم مستقيم الى عدة قطع طول الواحدة -ب

format→point styleاختيار شكل النقطة من .1-أ:الحل 

             draw→point→divideمن قائمة  .2

                   select objectتظهر الرسالة  .3

تظهر الرسالة,تحديد المستقيم بالنقر عليه بالماوس.4

5.Enter the number of segments :  5   

.    30نكتب5وبدلا من measureنختار divideيحل بنفس الخطوات ولكن بدلا من -ب
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Polylineامر رسم -

 يرسم الشكل الذي يحتوي على مستقيمات وأقواس بالأمرين خطlineوقوسarc, بينما يوفر امر
polylineو كما ه,نفس الامكانية بغض النظر عن ترتيب الشكل وبدون الخروج من امر الى اخر

polylineبواسطة امر 24ولرسم الشكل في ص, الحال عند الرسم بواسطة امري الخط والقوس

ى نعود ونذكر عند الانتهاء من كل سطر يجب النقر عل:والذي رسم سابقا بأمري الخط والقوس 

كما يتوجب النقر عليه للخروج من الامر بعد الانتهاء,enterمفتاح 
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 Poly lineرسم الشكل ادناه بأمر -

 الحل:

Polyline                                               

Start point : 0,150                               

Next point : 0,0                                   

Next point : 100,0                               

Next point : 100,150                           

 وتعني البدء برسم القوسArc                        

  وتعني ادخال قيمة الزاوية لاحقاA (Angle)       

  180قيمة الزاوية عكس عقرب الساعة             

End point : 0,150                                

 للخروج من الامر عند الانتهاءEsc                   

 يمكن كتابةCL( أي خيارClose) بدل كتابة إحداثيات
في الخطوة قبل الاخيرة (end point)النقطة الاخيرة 
 poly)عندما يستمر تنفيذ الامر ,لإتمام الرسم 

line) بدون انقطاع.
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الى ستة اقسام ؟Aقسم الشكل : س 
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: الحل 

*********

وذلك باستخدام خيار ,Formatتحديد شكل النقطة التي يقسم المستطيل بها من قائمة  1.
(point style ) دة يتم تحديد شكل النقطة من ضمن الخيارات الموجو ,فيظهر مربع الحوار

.فيختفي المربع OKوالنقر على ,وتحديد حجمها 

→ Draw  :Drawمن قائمة 2. point → Divide   .

.      Select object to divide:  تظهر الرسالة  3.

:تظهر الرسالة التالية , وبعد النقر على الشكل 4.

Enter the number of segments or [Block] : 6        .

والذي سيأتي شرحه  poly lineعلما ان الشكل رسم بأمر  ) فيتم تقسيم الشكل الى ستة اقسام 
( .لاحقا
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Ellipseامر رسم الشكل البيضوي -

 وعند النقر على امر ,لرسم الشكل البيضوي حسب المعلومات المتاحةellipse تظهر الرسالة
:التالية 

Specify axis endpoint of ellipse or[Arc/Center]:                         

:طرق ومن الرسالة يتضح ان رسم الشكل يتم باحدى الطرق التالية حسب المعلومات المتوفرة وال

:اعطاء البرنامج إحداثيات نهايتي المحور الاول ومسافة المحور الثاني ويتم ذلك 1.

Command:ellipse                                                                          

Specify axis endpoint of ellipse or[Arc/Center]:50,100                

Specify other endpoint of axis :400,100                                       

Specify distance to other axis or [Rotation]:80                             

يعني رسم الشكل بزاوية محددة عن المحور الاكبر rotationوخيار 

المحور بموجبه تعطى إحداثيات المركز ونهاية المحور الاكبر ومسافةcenterاعطاء البرنامج خيار 2.
. الاصغر 
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}اما لرسم قوس يمثل جزء من الشكل –{

تعطىArcيمكن رسم جزء من الشكل البيضوي وذلك بعد كتابة خيار arcوعن طريق خيار 3.

إحداثيات طرفي المحور الاكبر ثم مسافة المحور الاصغر ثم بداية الزاوية ثم مقدار الزاوية 

دوران عكس عقرب تكون قيمة الزاوية صفر من النهاية التي يتعرف البرنامج عليها أولا للمحور الاكبر وتكون موجبة عند ال)

(.الساعة
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Splineامر رسم شكل موجي -

 بعد النقر على رمزsplineاعا يرسم يطلب البرنامج النقاط التي سيمر بها وعند كتابة احداثياتها تب
.  الشكل المتموج مارا بالنقاط التي مرت من اول نقطة الى اخر نقطة 
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كيف يتم رسم الشكل التالي؟-

Spline                                                  

Specify first point or [Object] : 0,0    

Specify next point : 50,100                

Specify next point : 100,0                  

Specify next point : 150,-100             

Specify next point : 200,0                  

Specify next point : 250,100              

Specify next point : 300,0                  

Specify start tangent : enter                   

Specify end tangent : enter 

enter


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:ارسم الاشكال التالية 
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Modifyخيارات من قائمة التعديل :  الفصل الثالث 

    الثالثة:الوحدة التدريبية

          اجراء تعديلات على شكل تم رسمه اولايزال قيد العمل :الموضوع.

     النظرة الشاملة:

.طلاب الصف الاول :الفئة المستهدفة -أ

العديد من الاوامر يستفاد منها لمسح الاخطاء أو AutoCADيوفر برنامج :مبررات الوحدة-ب
اولمرات ,ثراوللاضافة اوللمسح والاضافة اولتكرار الرسم لمرة اواك,الزيادات غير المرغوب بها 

.اثناء عمليةالرسم أو بعدها وبوقت اسرع وبدقة متناهية ,عدة وفق نسق معين

.وكيفية التعامل معها لانجاز مهامها,  التعرف على اوامر التعديل : الفكرة المركزية-ج

Modifyسيكون الطالب قادرا على تنفيذ اوامر التعديل التالية من قائمة : اهداف الوحدة  -د

: والأوامر هي ,أو من شريط رموزه
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:الاوامر 

 امر المسحErase                 .• امر النسخCopy.

 المرآةMirror                 .•     امرOffset  .

 امرArray                         .• امرMove       .

 امرRotate                       .• امرScale       .

 امرStretch                      .•امرLengthen .

 امرTrim                         .•امرBreak       .

 امرChamfer                   .• امرFillet        .

امرExplode    .
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لإجراء أي عملية تغيير على الرسم قيد العمل بواسطة :1س:

. dimensionقائمة الابعاد-أ

.                 viewقائمة -ب

.                toolsقائمة -ج

.             modifyقائمة -د

:Modifyتستخدم قائمة التعديل :2س

.لرسم العناصر ◦

.لتصحيح خطأ في الرسم ◦

.  لحفظ الرسم -أ
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اوامر التعديل:الموضوع•

 امرالمسحErase:

:لمسح عنصر واحد أو اكثر نتبع الخطوات التالية 

(.تطلب تحديد العنصر لمسحه)Select objectsفتظهر الرسالة ,Eraseننقر على الامر 1)

.في لوحة المفاتيح enterنحدد العنصر المطلوب مسحه بالنقر عليه ثم ننقر على مفتاح 2)

:ملاحظات

.يتضح انه يمكن تحديد عنصر أو اكثر لمسحه select objectsمن الرسالة1.

حدا تلو يمكن التحديد بالمربع الصغير الذي يظهر على الشاشة بالنقر على العنصراوالعناصر وا2.
صريدخل وهنا يمسح أي عن,ويتم فتحها من اليمين الى اليسار )كما يمكن بفتح نافذة متقطعة,الاخر

ة أي غير كما يمكن التحديد بفتح نافذة بخطوط متصل,(  بكامله اوجزء منه في النافذة المتقطعة
(.لنافذة فقط وهنا تمسح العناصر التي تدخل بكاملها في ا,ويتم فتحها من اليسار الى اليمين)متقطعة

!  نوبعض الاوامر الاخرى بتحديد العنصر قبل طلب تنفيذ امر المسح ولكeraseيمكن تنفيذ امر 3.
 بعد تفعيل خيار 

ّ
:Toolsوذلك من قائمة Noun/verb selectionلايمكن ذلك الا

Tools→options→selection→Noun/verb selection                  
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امسح؟,في الشكل ادناه : س
.احد اضلاع المثلث -ب.    الخط الذي يقطع المثلث -أ

.المستطيل أو احد أضلاعه -د.               المثلث -ج
. كل العناصر الموجودة على شاشة الرسم -ه
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:الحل 

◊◊◊◊◊◊

:مسح الخط المستقيم 1)

.أو في شريط رموزهModifyفي قائمة العديل   eraseالنقر على امر ▪

و يظهر مربع صغير ينقر به على ,تسأل عن العنصر المطلوب مسحه Select objectsتظهر الرسالة  ▪
(.أي انه قد تم تحديده لغرض المسح ) المستقيم فيتحول الى خط منقط 

. enterينقر على مفتاح ▪

.نتبع نفس الخطوات السابقة, من اضلاع المثلث لمسح أي ضلع2)

النقر عليها ثلاثتها أو بتحديد اضلاع المثلث ب,لمسح المثلث يمكن تنفيذ خطوة التحديد بفتح نافذة متقطعة أو متصلة 3)
.كما في سبق 

امر لأنه رسم بأمر واحد وهو ) ولايمكن مسح احد اضلاعه لأنه عنصرا واحدا ,المستطيل كما سبق كل يمكن مسح 4)

الذي سيشرح  explodeبل يمكن مسح احد الاضلاع ولكن بعد استخدام امر ,(  rectangleمستطيل  
. Lineبينما كان ممكنا مسح الضلع لو تم رسم المستطيل بواسطة امر خط . لاحقا 

في شريط الاوامر لكي يتم  allأو بكتابة , كما في الخطوات السابقة , يمكن مسح كل ما موجود على واجهة الرسم 5)
.تحديد كل ما موجود على شاشة الرسم لمسحه 
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:Copyالامر •

 وفق الاتي ,ويستفاد من هذا الامر لعمل نسخة أو اكثر لعنصر مرسوم مسبقا:

كما يظهر المربع select objects: فتظهر الرسالة التالية في شريط الاوامرCopyننقر على رمز 1.
,enterثم النقر على مفتاح ,(السابقة 2كما وضح في الملاحظة رقم )الصغير ويتم التحديد 

:فتظهر الرسالة التالية 

Specify base point or displacement, or [Multiple]:            

ر من نسخة ولعمل اكث,سواءً مكانها على العنصر أو خارجه ,وتطلب تحديد نقطة تنفيذ امر الاستنساخ 

.enterثم ننقر (Multipleأي اننا سنستخدم خيار)mنكتب حرف

:تظهر الرسالة التالية 2.

Specify second point of displacement or,<use first point as 
displacement>:                                                             

.قطةأي اختيار النقطة التي ينفذ فيها النسخ فتظهر نسخة جديدة من العنصر في تلك الن

.يمكن تحديد أي نقطة بواسطة الماوس اوبكتابة احداثياتها في شريط الاوامر:ملاحظة
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:انسخه , Copyبالأمر , Aالشكل : س 
.عدة مرات-ب.  مرة واحدة -أ
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:الحل 

◊◊◊◊◊◊

:نسخ الشكل لمرة واحدة فقط -أ

.أو في شريط رموزه  Modifyفي قائمة   Copyالنقر على امر 1)

ربع ويتم التحديد بواسطة الم, لتحديد عنصر أو اكثر لاستنساخه  Select objectsتظهر الرسالة  2)
. enterثم النقر على مفتاح  , الصغير أو بفتح نافذة 

فيتم    : specify base point or displacement, or [Multiple]: تظهر الرسالة 3)
.تحديدها  بالنقر بالماوس أو بكتابة احداثياتها في شريط الاوامر 

لتحديد النقطة التي يتم فيها   specify second point or displacement:  تظهر الرسالة 4)
.وينفذ لمرة واحدة فقط, الاستنساخ 

:لتنفيذ الامر لرسم عدة نسخ للشكل -ب

أولا mابة حرف يجب كت, يتم التنفيذ بنفس الطريقة ولكن عند ظهور الرسالة في الخطوة الثالثة اعلاه 
بالنقر بالماوس أو بكتابة ( base point)ثم في الخطوة التالية تحدد نقطة التنفيذ الاساسية 

.ها كذلك في الخطوة الرابعة يتم النقر في الاماكن المطلوب الاستنساخ في,الاحداثيات 
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:Mirrorامر المرآة 

ويتم تنفيذ الامر كما يلي:وهو عملية اظهار رسم على مرآة

.enterنحدد العناصر ثم النقر على مفتاح select objectsفتظهر الرسالة ,النقر على رمزالامر1)

فتحدد نقطة اولى في أي مكان نرغب بوضع  specify first point of mirror lineتظهر الرسالة2)
.الطرف الاول للمرآة فيه 

.فتحدد النقطة الثانية  specify second point of mirror lineتظهر الرسالة3)

أي )وتسأل هل نريد مسح العنصر المصدر,:Delete source objects[Yes/No]تظهر الرسالة 4)
اما اذااردنا ابقاء العنصر الاساس ي ,yفأن كان كذلك فيكتب حرف (وليس الصورة,العنصر الموجود اصلا

Noبدون أي كتابة اشارة ً على الموافقة على تنفيذ الخيار الافتراض يenterوالصورة ينقر على مفتاح 

.> <المكتوب بين القوسين
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على الشكل ادناه ؟ Mirrorنفذ الامر : س 
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:Offsetامر 

الحاجة وعلى احدى الجهتين حسب,ويرسم عنصر مشابه لعنصر مرسوم يبعد عنه بمسافة يمكن تحديدها
ل حسب أو يرسم عنصر مشابه له نفس المركز ولكن داخل أو خارج العنصر الاو ,(اذا كان العنصر مستقيم)

:ولتنفيذ الامر نتبع الاتي ,(اذا كان العنصر دائرة اومستطيل أو شكل بيضوي مثلا)التحديد 

:<specify offset distance or [Through]<1.000تظهر الرسالةOffsetننقر على 1)
مج  أي ان البرنامج يسأل عن المسافة التي تفصل العنصر الجديد عن العنصر الاصلي والبرنا

وإذا اردنا مسافة اخرى ,enterفإذا وافقنا على هذه المسافة ننقر على مفتاح<1.000>يفترضها
فانه يعني اننا نريد العنصر الجديد يمر خلال نقطة Throughاما خيار ,enterنكتبها ثم نقر على 

.ثم نحدد تلك النقطة Enterثم ننقر على Tمعينة يمكن ان نحددها بعد ان نكتب حرف 

فيتم          :<Select object to offset or <exit:تظهر الرسالة التالية 2)
ينفذ الامر واحد فقط ولايمكن تنفيذه لعدة offsetيلاحظ ان الامر,تحديدالعنصرلرسم مشابه له

.وبعد تحديد العنصر بالنقر عليه ,عناصر دفعة واحدة

فيتم تحديد الجانب            :Specify point on side to offset:تظهر الرسالة التالية3)
.الذي سيتم التنفيذ فيه بالنقر بالماوس

.يعني الخروج من الامردون تنفيذ <exit>الخيار:ملاحظة 
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:ارسم, offsetباستخدام امر : س -أ
.مرة اعلاه ومرة اسفله ,Aمستقيم مشابه للخط -أ

.داخلها وخارجها Bدائرة مشابهة للدائرة -ب
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:الحل 

◊◊◊◊◊

.أو في شريط الرموز , Modifyفي قائمة  Offsetبعد النقر على امر 1)

وتسأل عن المسافة ,: <Specify offset distance or [Through] <1.0000تظهر الرسالة  2)
ويلاحظ وجود {. <1.0000>علما ان الخيار الافتراض ي هو , وحدة 15التي يبعد بها العنصر الجديد وهي 

و بكتابة في الرسالة ويعني رسم العنصر المشابه في نقطة ما يتم تحديدها بالماوس أ[Through]الخيار 
في الخطوة  enterفي شريط الاوامر ثم النقر على مفتاح tاحداثياتها في شريط الاوامر يسبقها كتابة حرف 

.}في نقطة معينة ثم يتم تحديدها offsetالاولى دلالة على اننا نريد تنفيذ الامر 

.فننقر على الخط , لتحديد العنصر   : < Specify object to offset or < exitتظهر الرسالة 3)

لتحديد الجانب الذي يرسم فيه العنصر  : Specify point on side to offsetتظهر الرسالة  4)
.وحدة 15فيرسم اعلاه خط مشابه على مسافة . المشابه وهنا في الجهة اعلى الخط 

يلاحظ وجود {.: < Select object to offset or < exitثم ينقر على الخط عند ظهور الرسالة  5)
.}للخروج من الامرexitالخيار 

فيرسم الخط اسفل ,  : Specify point on side to offsetوينقر اسفل الخط عند ظهور الرسالة 6)
.Aالخط  

.ومرة خارجها Bولكن مرة داخل الدائرة ,تتبع نفس الخطوات اعلاه ,لرسم الدوائر 7)
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:Arrayامر •

 يستخدم لتكرار رسم عنصر مرسوم بأي عدد وبأي مكان وفق الاتي:

يحتوي خيارين وهماArrayفيظهر مربع حوار بإسم Arrayننقر على امر 

اختياره ويمكن تفعيله بالنقر في الدائرة فتظهر نقطة سوداء أي انه تم:Rectangle Arrayخيار -❑
:وعند اختياره يمكن التحكم ,وبالنقر مرة ثانية تختفي النقطة أي انه تم الغاء العمل به

.نكتب عدد الصفوف Rowsعدد الصفوف من خلال الخانة 1.

.نكتب عدد الاعمدة Columnsعدد الاعمدة من خانة 2.

. Row offsetتحديد المسافة بين الصفوف 3.

.Column offsetتحديد المسافة بين الاعمدة 4.

تظهر المصفوفة على شكل 0فاذا كانت الزاوية ,Angle of arrayتحديد زاوية ميل الترتيب 5.
ة الزاوية اما بكتابة زاوية فان المصفوفة تظهر ملائمة لقيم,صفوف وأعمدة متعامدة مع بعضها 

.أي مدورة حسب قيمة الزاوية 

في مربع الحوار فيختفي select objectsبعد تثبيت الخيار المطلوب في الفقرات اعلاه ننقر على 
فيتم OKفيظهر مربع الحوار ثانية ننقرenterالمربع فنحدد العنصر بالنقر عليه ثم ننقر 
.انجازالرسم المطلوب على شكل مصفوفة 
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تتمة:  Arrayامر 

Polar Array :خيار   ❑

Total number of itemsويوفر امكانية لتكرار رسم العنصر المطلوب بالعدد الذي نحدده في خانة 

 selectثم ننقر على مربع  Angle to fillمنتشرة على محيط دائرة أو جزء منها نحددها من خانة 

objectsيظهر المربع ثانية في اعلى يمين مربع الحوار فيختفي المربع وننقر على العنصر لتحديده ثم النقر ف
.فيتم انجاز الرسم المطلوب OKفننقر على 
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: Arrayالمطلوب رسمها بأمر , دائرة , الشكل التالي ادناه : س 
.ثلاثة صفوف وأربعة اعمدة, دائرة على شكل مصفوفة 12-أ

.°360دائرة موزعة على شكل دائري 12-ب

 بعد النقر على امرArray,يظهر مربع الحوار:

. Rectangle Arrayنختار 1)

Columnsوفي خانة ,3نكتب  Rowsفي خانة 2)
.4نكتب 

نكتب المسافة بين  Row offsetفي خانة 3)
 Columnsوفي خانة , مثلا 50الصفوف 
offset مثلا 70نكتب المسافة بين الاعمدة.

لكي تكون 0نكتب Angle of arrayفي خانة  4)
ة اما لو اردنا المصفوف,الصفوف والأعمدة متعامدة 

.مائلة نكتب زاوية الميل في هذه الخانة 

يختفي المربع Select objectsننقر على 5)
قر على ويظهر المربع الصغير ننقر على الدائرة ثم نن

. enterمفتاح 

OKللمشاهدة اوعلى previewننقر على 6)
. لتثبيت الخيار 
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:تتمة الحل -

:يظهر مربع الحوار  Arrayبعد النقر على 

. Polar Arrayنختار 1)

نكتب  Total number of itemsفي خانة 2)
.12عدد العناصر 

.360نكتب  Angle to fillفي خانة 3)

ونحدد العنصر ثم  Select objectsننقر على 4)
. enterننقر على 

لتثبيت  OKيظهر مربع الحوار ثانية ننقر على 5)
.الخيار 
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:Moveامر •

:وفق الخطوات التالية ,باستخدامه يمكن نقل عنصر مرسوم أو اكثر الى مكان اخر 

اح يطلب تحديد العنصر لنقله فيتم تحديده ثم النقر على مفت,Moveبعد النقر على امر 1.
enter.

.بالنقر عليها (base point)تحديد نقطة التنفيذ 2.

.تحديد النقطة التي ينقل اليها العنصر3.
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المطلوب نقل المستطيل من مكان الى اخر ؟,في الشكل ادناه : س 

 Moveبعد النقر على امر 

, ويظهر المربع الصغير  Select objectsتظهر الرسالة 1)
.enterنحدد العنصر بالنقر عليه ثم النقر على  

: تظهر الرسالة 2)

Specify base point or displacement

.ننقر في أي نقطة 

:تظهر الرسالة 3)

Specify second point                       

ر الى تلك فينتقل العنص,ننقر في أي نقطة مطلوب النقل اليها 
.النقطة 
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:Rotateامر  •

:وذلك ,باستخدامه يمكن تدوير العنصر من نقطة محددة وبزاوية محددة 

.enterثم النقر على مفتاح ,ثم يحدد العنصر ,Rotateالنقر على امر 1.

.تحديد النقطة الاساسية التي يتم التدوير منها مع بقاء طرفه ثابتا فيها 2.

.يتم تحديد المكان الجديد أي تدويرالعنصربزاوية يتم تحديدها في هذه الخطوة 3.
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؟45مطلوب تدويره بزاوية Aالمستطيل : س 
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بعد التدوير



:Scaleامر •

:حيث يمكن تكبير أو تصغير عنصر أو شكل من خلال 

.enterثم تحديد العنصر ثم ,Scaleالنقر على امر 1.

.تحديد النقطة التي يتم منها التكبير أو الصغير 2.

ندما ع)ويكون معامل تصغير ,( عندما نكتب اكبر من واحد)ثم نكتب معامل التكبير 3.

(.نكتب اقل من واحد
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.المطلوب تكبير المستطيل الى الضعف : س 
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اختبار ذاتي

بعد التكبير



:الحل 

◊◊◊◊◊◊

 بعد النقر على امرScale :

. enterيحدد العنصر ثم النقر على مفتاح   Select objectsتظهر الرسالة  1)

التي ينفذ امر ال, يتم تحديد النقطة الاساسية  Specify base pointفي الرسالة  2)

.2نكتب  Specify scale factorفي الرسالة  3)

.فيكبر الشكل الى الضعف 
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:Stretchامر •

:خطواتوينفذ الامربال,حيث يمكن مط الشكل من ركن واحد على الاقل أي الضلعين التي تقطعهما النافذة 

.Stretchالنقر على امر 1.

.فتح نافذة تتضمن ركن واحد من الشكل أو ركنين 2.

.أي النقطة التي تجري منها عملية المط ,تحديد النقطة الاساسية للتنفيذ 3.

.سحب الركن الى المكان المطلوب بواسطة الماوس أو بكتابة الاحداثيات 4.
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؟( لسحبه )على المستطيل لمطه  Stretchالمطلوب تنفيذ امر : س 
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بعد المط 



:الحل 

◊◊◊◊◊◊

 بعد النقر على امرStretch :

. Select objectsتظهر الرسالة  1)

ثم , كن من ذلك الر ( السحب ) يجب فتح نافذة تضم ركن واحد على الاقل من اركان المستطيل ليتم المط 2)

. enterالنقر على مفتاح 

. لتحديد النقطة الاساسية   Specify base point or displacementفي الرسالة  3)

لتحديد النقطة التي يمط العنصر وهو   Specify second point of displacementفي الرسالة  4)
.المستطيل اليها 
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:Lengthenامر •

:وهي ,حيث يمكن يمكن تطويل مستقيم أو قوس بطرق مختلفة حسب الخيارات الموجودة في الامر 

وفيه تتم زيادة طول مستقيم أو قوس أو تقصيرهما من خلال:Deltaخيار-أ

يم ثم والنقر على المستقيم المعني بالامر فتظهر قيمة طول المستقlengthenالنقر على امر 1.
. enterثم نقر ( deltaاشارة الى خيار )deنكتب 

م بقدر تلك فإذا كانت قيمة موجبة يزداد طول المستقي,نكتب قيمة التغيير المرغوبة في الطول 2.
.القيمة اما كانت القيمة سالبة يقل طول المستقيم أو القوس بقدرها 

طول زيادة أو نقصان بنسبة مئوية مقارنة بال,وفيه يتم تغيير طول العنصر:Percentخيار-ب
اما لكي يكون اقصر يكتب اقل من ,100لزيادته بكتابة رقم اكبر من )%100الاصلي باعتباره 

(.فيقصرطول المستقيم أو القوس حسب النسبة المدرجة100

.وفيه يتم اعطاء الطول الكلي الجديد بغض النظر عن الطول الاصلي :  Totalخيار-ج

.وفيه تتم زيادة اونقصان طول المستقيم اوالقوس بواسطة حركة الماوس:Dynamicخيار -د

في الخيارين enterثم نقرعلى aبكتابة حرف Angleللتعامل مع القوس من خلال خيار :ملاحظة 
DeltaوTotal ومن خلال الطول كنسبة مئوية للزيادة أو النقصان في خيارPercent ومن

.Dynamicخلال حركة الماوس في خيار 
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ارسم العناصر التالية كما مفصل ادناه؟: س 

 المستقيمA, تم تنفيذ الامرLengthen  خيارDelta وذلك , عليه:

.Bالمستقيم , وحدة 50لتطويله بمسافة 1)

.Cالمستقيم ,  30-لتقصيره بمسافة 2)

 القوسD , بتنفيذ الامرLengthen  خيارDelta وذلك , عليه:

.Eالقوس , وحدة 50لتطويله بمسافة 1)

.Fالقوس , 30-لتقصيره بمسافة 2)

.Gالقوس , (20بزاوية موجبة ) لتطويل القوس 3)
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:الحل 

◊◊◊◊◊◊

 بعد النقر على امرLengthen  , تظهر الرسالة التالية:

(1Select an object or [Delta/ Percent/ Total/ Dynamic] : de

ولم نكتف بالحرف الاول فقط  , deبكتابة اختصاره الحرفين Deltaدلالة على اننا اخترنا تنفيذ الامر بالخيار الفرعي 
. DYnamicمن ضمن الخيارات وهو خيار Dوذلك لوجود خيار اخر يبدأ بالحرف 

: وتسأل عن مقدار فرق الطول  <Enter delta length or [Angle] <0.0000:  تظهر الرسالة 2)

50يطول العنصر (قيمة موجبة ) 50نكتب مقدار فرق الطول ,اذا كان العنصر مستقيم أو قوس -أ

) 30-وإذا كتبنا  , Eويطول القوس ويصبح بطول القوس Bيطول المستقيم بطول المستقيم , وحدة 
.Fوقصر القوس ليكون بطول القوس Cيقصر طول المستقيم ليكون بطول المستقيم ( قيمة سالبة 

ننقر على القوس لتحديده   : Select an object to change or [Undo]: تظهر الرسالة -ب
.

,  enterثم النقر على مفتاح aبكتابة حرف Angleيمكن استخدام الخيار  قوسا اذا كان العنصر -ج
-اما لو كتبنا الزاوية سالبة  Gموجبة يطول القوس ليكون بطول القوس 20وعند كتابة قيمة الزاوية 

.لقصر القوس 20

.للقوس فقط ولايمكن استخدامه للمستقيم Angleيمكن استخدام خيار الزاوية -1:ملاحظة 

.من النهاية القريبة من نقطة نقر المؤشر عند تحديد العنصرLengthenينفذ الامر -2
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كما مطلوب في ادناه ؟,ارسم العناصر التالية : س 

.وحدة 150الى طول Dوالقوس ,Aتطويل المستقيم -1
.وحدة 100تقصيرهما ليصبح طول كل منهما -2

.100تطويل القوس بدلالة الزاوية ليصبح طوله -3
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:الحل 

◊◊◊◊◊◊

 : Command:  لتنفيذه Lengthenتم اختيار الامر 1)

Lengthen                                     

(2Select an object or [ Delta/ Percent/ Total/ Dynamic ] : t  في الرسالة تم اختيار
. enterثم النقر على مفتاح tوذلك بكتابة الحرف  Totalتنفيذ الخيار 

وتسأل عن الطول الكلي  , Specify total or [Angle] <1.0000> : 150:  تظهر الرسالة  3)
150وطول القوس ( Bبطول المستقيم )وحدة 150ليكون طول المستقيم ,  enterثم 150أدرج الطول ◄

( .Eبطول القوس )

وأصبح , ( Cبطول المستقيم )وحدة 100لأصبح طول المستقيم ,  Enterثم نقر100اما لو ادرج الطول ◄
بعة بغض النظر عن طول العنصر الاصلي بجميع  التطبيقات الار , ( Fبطول القوس )100طول القوس

.اعلاه 

بكتابة  Totalوبعد اختيار , وللتنفيذ ) ولا يمكن تنفيذه على المستقيم , ينفذ على القوس  Angleخيار 4)
فيصبح ,90ثم كتابة قيمة الزاوية ,  enterثم ننقر مفتاح aبكتابة حرف  Angleنختار الخيار tحرف 

. Gالقوس بطول القوس 
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كما مطلوب ادناه ؟,ارسم العناصر التالية : س 

.%30بنسبة Dوالقوس Aتطويل المستقيم -1
.%30تقصيرهما بنسبة  -2
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:الحل 

◊◊◊◊◊◊

(1Command : 
Lengthen                                                                                

          Select an object or [DElta/ Percent/ Total/DYnamic] : p:  تظهر الرسالة 2)

. enterثم نقرpبكتابة حرف  Percentأدرج الخيار 

ادرج الرقم ◄,                                           Enter percentage length : 130:  تظهر الرسالة 3)
فيصبح طول ,%30وان الزيادة المطلوبة هي %100أي باعتبار الطول الاصلي ,على اعتباره نسبة مئوية 130

فانه 70اما لو ادرج الرقم ◄Eليصبح بطول القوسDويزداد طول القوس , Bبطول المستقيم Aالمستقيم
ويقصر , Cليصبح بطول المستقيم %30يقصر بنسبة Aأي ان طول المستقيم , يمثل نسبة مئوية للتقصير

. Fليصبح بطول القوس Dطول القوس 

حيث هناك , Lengthenعند وجود اكثر من خيار يبدأ بنفس الحرف كما في الامر : ملاحظة 
يجب كتابة اكثر من حرف واحد dوأول حرف فيهما ,DEltaوالخيار  DYnamicالخيار

زية الكبيرة ويكتب البرنامج اختصار الخيار بالحروف الانكلي, للدلالة على تشخيص الخيار المقصود 

(capital letter ), وهي الحروف التي يجب كتابتها للدلالة على ذلك الخيار.
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:   Trimامر•

وات ويتم من مكان القطع وذلك وفقا للخط,بواسطته يتم مسح جانب واحد من عنصر مقطوع بعنصر اخر 
:التالية 

. Trimالنقر على امر 1.

.يطلب البرنامج تحديد العنصر الذي يبقى بدون تغيير فينقر عليه 2.

.انب الاخرولايمكن مسح الج,فينقر عليه فيتم مسحه ,تظهر رسالة تسأل عن الجانب الذي يراد حذفه 3.

للعناصر المتقاطعة الاخرى كالدوائر أو المستطيلات أو الاقواس أو أي Trimيمكن تنفيذ امر :ملاحظة 
.عنصرين متقاطعين 
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:المطلوب مسح ,في الاشكال التالية : س 

.Aفي الشكل Dمايقع يمين المستقيم -1
.B,Cفي كلا الشكلين Dماهو داخل المستطيل -2
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:الحل 

◊◊◊◊◊◊

. Trimبعد النقر على امر 1)

دد فح,لتحديد العنصر الاساس الذي يبقى بدون تغيير لمواصفاته   Select objects: تظهر الرسالة 2)
. Enterثم نقر على A,B,Cفي الاشكال Dالعنصر 

وهي اجزاء العناصر التي, لتحديد الاجزاء المطلوب مسحها  Select objects to trim:  تظهر الرسالة 3)
.B,Cوأجزاء العناصر التي تقع داخل المستطيل في الشكلين , Aفي الشكل Dتكون يمين العنصر 

سح والملاحظ انه اذا مسح احد الجانبين لعنصر فلا يمكن م, في الخطوات السابقة Trimتم تنفيذ الامر 4)
دون الجانب الايمن أو مسح اجزاء Aكما انه كان يمكن مسح الجانب الايسر في الشكل . الجانب الثاني 

.دون الاجزاء داخل المستطيل  B,Cالعناصر خارج المستطيل في الشكلين 
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: Extendامر •

مديده في ولايمكن ت,ويستخدم لمد عنصري الخط اوالقوس الى ان يلتقي بعنصر اخر موجود في طريقه حتما
:ويتم التنفيذ وفق الاتي ,كما لايمكن تمديد عناصر كالدوائر والمستطيلات ,الفراغ  

.يتم تحديد العنصر الذي سيمدد اليه ,Extendبعد النقر على امر 1.

.يطلب البرنامج تحديد العنصر الذي يراد تمديده 2.
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للمستطيل ؟2و1لتمديد المستقيمين Extendالمطلوب تنفيذ الامر, Aفي الشكل : س 
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:الحل 

◊◊◊◊◊◊

. Extendبعد النقر على امر 1)

ير لتحديد العنصر الاساس ي الذي سيمدد العنصر الاخر اليه دون تغي Select objects: تظهر الرسالة 2)
.في مواصفاته 

لتحديد الخطوط التي ستمدد الى ان تصل الى العنصر  Select object to extend: تظهر الرسالة 3)
وذلك لان امتداده لايتقاطع 2بينما لايمكن تنفيذ الامر على الخط رقم ,1ولذلك سيمدد الخط رقم , الاساس 

:مع المستطيل وتظهر الرسالة 

Object does not intersect an edge
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: Breakامر •

:وذلك ,ويستخدم لعمل قطع أو فتحة في الخط اوفي احد اضلاع المستطيل 

.Breakالنقر على الامر 1.

.فيحدد المستقيم أو المستطيل select objectتظهر الرسالة 2.

:تظهر الرسالة التالية 3.

Specify second break point or [First point]: f              

.enterثم ننقر fنكتب حرف 

.نحدد النقطة الاولى للقطع ثم النقطة الثانية فيتم مسح المسافة بين النقطتين4.

م النقر على ث,كان من الممكن اعتبار النقطة التي تم تحديد العنصر فيها هي نقطة بداية القطع 5.
ديد ولاشك يمكن تح. النقطة مباشرة عند ظهور الرسالة اعلاه لمسح الجزء بين النقطتين 

.النقطتين بواسطة كتابة احداثياتهما في شريط الاوامر 
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المطلوب قطع المستقيم أو المستطيل ؟,ارسم الاشكال التالية : س 
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:الحل 

◊◊◊◊◊◊

لتحديد عنصر واحد وهو المستقيم في  Select objectتظهر الرسالة ,Breakبعد النقر على امر 1)
.Aالشكل 

:وتظهر الرسالة , تعتبر النقطة التي تم النقر فيها بداية القطع 2)

Specify second break point or [First point] :   نهاية القطع ) وتحدد النقطة الثانية
.فيمسح جزء المستقيم بين نقطتي البداية والنهاية ,(

.على أي من اضلاع المستطيل بنفس الطريقة لمسح جزء منه Breakيمكن تنفيذ الامر 3)

يمكن ,  Specify second break point or [First point] : f: عند ظهور الرسالة السابقة 4)
. enterثم نقر مفتاح fوذلك بكتابة حرف , تحديد نقطة بداية قطع اخرى للقطع 

.لتحديد نقطة بداية القطع   Specify first break point: تظهر الرسالة 5)

فيتم مسح الجزء بين , لتحديد نهاية القطع   Specify second break point: تظهر الرسالة 6)
.النقطتين 

92



: Chamferامر •

ن القطع ويمكن ان يكو ,ويستخدم لعمل قطع في الركن أو بين عنصرين متقاطعين في نقطة التقاطع 

:ولتطبيق الامر نتبع الاتي ,متساوي على الخطين المتقاطعين أو مختلف 

ع وقيمة القط(المسافة الاولى)فتظهر الرسالة لإدخال قيمة القطع Chamferننقر على امر 1)
ى الخط الثاني على المستقيم الثاني فان تمت الموافقة على القيمتين ننقر على الخط الاول ثم عل

.فيظهر التطبيق ,

ثم النقر على ( مسافة القطع  distanceاي) dاذا رغبنا في تغيير قيمة القطع نكتب حرف2)
enter , خط الثاني ثم نحدد الخط الاول ثم ال,ثم نحدد المسافة الاولى للقطع ثم المسافة الثانية

.الثاني فيظهر القطع بمسافة حسبما ثبت في الخطوة السابقة قبل تحديد الخطين الاول و ,

والفرق بين , filletوالأمر الذي يليه chamferمر بنا سابقا في رسم المستطيل ذكر الامر: ملاحظة
ل يكون ذكرهما فيما سبق والان هو ان الخيارين كانا من ضمن المواصفات اما الان فان المستطي

قد رسم سابقا بدون مواصفات ثم ينفذ عليه احد الامرين  

93



:المطلوب ,مستطيل وخطان متقاطعان Aفي الشكل : س 
Bكما في الشكل 10لعمل قطع متساوي المسافتين  Chamferتنفيذ امر -1

.Cكما في الشكل D1=10,D2=20عمل قطع مختلف -2
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:الحل 

◊◊◊◊◊◊

:تظهر الرسالة , Chamferبعد النقر على امر 1)

Select first line or [Poly line/ Distance/ Angle/ Trim/ Method] : d          , ثم نكتب
. enterفي شريط الاوامر ثم نقر مفتاح dحرف 

علما ان المسافة ,  : <Specify first chamfer distance <10.0000:  تظهر الرسالة 2)
وإلا نكتب , ( كما هي في هذا السؤال )مباشرة enterفأن كانت ملائمة ننقر على مفتاح ,10الافتراضية للقطع 

.enterالمسافة المطلوبة ثم نقر مفتاح 

كما هو الحل في ,  : <Specify second chamfer distance <10.0000: تظهر الرسالة 3)
.الخطوة السابقة 

يه لتحديد المستقيم الاول الذي ينفذ امر القطع عليه بالنقر عل, : Select first line: تظهر الرسالة 4)
.لتحديد المستقيم الثاني بالنقر عليه ايضا ,  Select second line: فتظهر الرسالة الثانية ,

اما في , (10وهي )في حالة مسافة القطع الاولى والثانية متساويتان Bفي الشكل  Chamferتم تنفيذ امر 5)
.20ومسافة القطع الثانية 10فان مسافة القطع الاولى Cالشكل 
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: Filletامر •

:وذلك ,ويستخدم لعمل تقويس في ركن أو بين خطين متقاطعين 

تظهر الرسالة توضح قيمة نصف قطر القوس الذي يراد رسمه فأن,Filletبعد النقر على امر 1.
.نجاز الامر كان نصف القطر الافتراض ي هو المطلوب يحدد الضلع الاول ثم الضلع الثاني فيتم ا

ثم , (أي اننا نريد ادخال قيمة اخرى لنصف القطر )Rاذا كان نصف القطر بقيمة اخرى نكتب 2.
ول ثم ثم يحدد المستقيم الا ,ثم نكتب قيمة نصف القطر في الخطوة اللاحقة ,enterننقر على 

. فينجز تنفيذ الامر ,الثاني 
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المطلوب عمل تدوير في ؟ ,مستطيل وخطان متقاطعان Aفي الشكل : س 
.10في احد اركان المستطيل بنصف قطر -1

.10في تقاطع المستقيمين نق -2
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: الحل 

◊◊◊◊◊◊

علما ,  : Select first object or […/ Radius/…]تظهر الرسالة , Filletبعد النقر على امر 1)
.10ان نصف القطر الافتراض ي 

 Selectية فتظهر الرسالة الثان,اذا كانت القيمة الافتراضية ملائمة يحدد المستقيم الاول بالنقر عليه 2)

second object ويتم تنفيذ امر ,فيتم تحديد المستقيم الثاني بالنقر عليه ايضاFillet كما في الشكل
B في ركن المستطيل وعند تقاطع المستقيمين.

ثم ادراج قيمة نصف القطر ,enterثم نقر مفتاح Rنكتب حرف , اذا كانت القيمة الافتراضية غير ملائمة 3)
.ويحدد المستقيم الاول ثم الثاني كما سبق . enterالملائمة ثم النقر على مفتاح 
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: Explodeامر •

ويستخدم لتفجير عنصر مرسوم سابقا بأمر واحد مثل المستطيل اوشكل مرسوم بأمر 

polyline احد اضلاع مستطيل عند رسمه بأمر )حيث لايمكن مسح جزءRectangle او أي جزء
:ولتنفيذ امر التفجير نتبع الخطوات التالية ,( Polylineمن شكل مرسوم بأمر 

.enterثم النقر على ,ثم تحديد الشكل بالنقر عليه , Explodeالنقر على امر 1)

حظ يلا )يحدد ذلك الجزء ,الان يمكن تنفيذ أي من اوامر التعديل على جزء من العنصر المفجر 2)
منفصلة انه تم تحديده فقط أي انه تم تفجير الشكل وصار ممكنا التعامل مع اجزائه كعناصر

(.كل لحاله 

:ملاحظة عامة 

او من شريط . Modifyجميع اوامر هذا الفصل يمكن تنفيذها اما من القائمة المنسدلة 
. Modifyالرموز 
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في العنصرين علما ان كل منهما قد رسم بأمر واحد؟1على الجزء Moveنفذ الامر :س 
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:الحل 

◊◊◊◊◊◊

لذا لايمكن تنفيذ أي امر ,RectangleوPoly lineبما ان العنصرين قد رسم كل منهما بأمر واحد وهما 1)
. يه كله من اوامر البرنامج على جزء من العنصر لان كل من العنصرين يمثل عنصرا واحدا بل ينفذ الامر عل

ن يجب فك الارتباط بي(في العنصرين مثلا 1على الجزء رقم Moveتنفيذ امر )ولتنفيذ أي امر على جزء منه 
.Explodeولايتم ذلك إلا باستخدام امر ( أي تفجير العنصر ) اجزاء العنصر 

ويتم تحديدهما بالنقر عليهما ثم , Select objectsتظهر الرسالة التالية Explodeبعد النقر على امر 2)
صرا وهنا يكون كل من العنصرين قد تم تفجيرهما وأصبح كل جزء من اجزائه عن.  enterالنقر على مفتاح 

.لحاله 

:في كل من العنصرين 1ننفذ الامر على الجزء رقم , للتأكد من ذلك 3)

.في العنصرين 1وينقر على الجزء رقم  Select objectsتظهر الرسالة , Moveينقر على امر -أ

 second point)وتحديد النقطة الثانية , ( base point)بعد تحديد نقطة التنفيذ الاساسية -ب

في العنصرين الى مكانه الجديد الذي تم 1يتم التنفيذ بنقل الجزء رقم , التي سيتم نقل العنصر اليها  (
.Aبعد ان كان الشكل كما في Bوتم انتاج الشكل . تحديده بالنقطة الثانية 
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ادوات العرض والرؤية  والإزاحة:الفصل الرابع 

     الاولى :الوحدة التدريبية .

           اوامر : الموضوعZoomوPan .

       النظرة الشامة:

.طلاب الصف الاول :الفئة المستهدفة     -أ

وح ابعاد بعض الاشكال التي يجب رسمها صغيرة مما يؤدي الى عدم وض:مبررات الوحدة    -ب
.ير أو الازاحة وأحيانا يراد التصغ,الرؤية وصعوبة تنفيذ مفردات الرسم مما يستوجب التكبير

خر على التمكن من الرؤية بشكل مناسب لابعاد الرسم ونقله من مكان لآ :الفكرة المركزية   -ج
.شاشة الرسم 

:سيكون الطالب قادرا على :اهداف الوحدة     -د

.التحكم في ادوات الرؤية _ 

التحكم في ادوات الازاحة_ 
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يمكن الوصول الى خياري :1سZoom وPanمن قائمة ؟

.         Draw-أ

. Dimension-ب

.         View-ج

.      Modify-د
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.Zoomامر العرض والرؤية  _ :الموضوع 

. Panامر الازاحة _ 

 امرZoom :

. Viewمن خلال قائمة  Zoomيمكن الوصول للأمر 1.

. Standard Toolbarsيمكن الوصول من خلال شريط الادوات الادوات الرئيسية 2.

.Enterفي شريط الاوامر ثم نقر  Zكما يمكن بكتابة حرف 3.

ما تؤدي الى وان,والجدير بالذكر ان تنفيذ خيارات هذا الامر لاتؤدي الى تكبير حقيقي للشكل أو ابعاد الرسم _ 
هام بشكل ادق التكبير لإغراض توضيح الرؤية فقط بحيث يمكن رؤية المستند بشكل اوضح وانجاز الم

.وأسهل 

:وعند تطبيق احدى الطرق اعلاه تظهر قائمة تحتوي على الخيارات التالية 

.للتكبير والتصغير حسب حركة الماوس : Realtimeخيار -أ

.أي العودة للخيار السابق :  Previousخيار -ب

.أي فتح نافذة متقطعة لتكبير ما بداخلها على كبر واجهة الرسم :  Windowخيار -ج

:وعند تشغيله تظهر ثلاثة نوافذ : Dynamicخيار -د
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المطلوب تكبير الجزء داخل النافذة ؟,Aفي الشكل : س 

 الحل:

بعد النقر على خيارWindow  في قائمةView(View → Zoom → Window) , أو في شريط الادوات
. القياس ي 

  تظهر الرسالةSpecify first corner , فينقر في نقطة بداية النافذة فتفتح النافذة وتعتبر ركن النافذة.

 تظهر الرسالةSpecify opposite corner  ,ة الاجزاء فينقر في نقطة تمثل الركن المناظر للنافذة بحيث تضم النافذ
.بحيث ان النافذة تغطي تمام مساحة الواجهة , المطلوب عرضها مكبرة على واجهة الرسم 
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تتمة  zoomامر 

 زرقاء بخط متقطع تبين حدود الرسم : الاولى.

 خضراء بخط متقطع تبين اخر تكبير تم عمله : الثانية.

 بيضاء وهي نافذة التكبير وتكون بخط غير متقطع تظهر علامة : الثالثةx وللتنفيذ نحرك النافذة ,في وسطها
اوس ونحدد كبر البيضاء بواسطة الماوس الكي يكون الجزء المراد تكبيره داخل هذه النافذة ثم نضغط يسار الم

على →الى سهم xأي انه نفس الوقت الذي نضغط على يسار الماوس وتتحول علامة )النافذة بنفس الوقت 
على وبعد تحديد كبر النافذة ننقر( ونحرك الماوس فتكبر أو تصغر حسب الحاجة ,احد اضلاع النافذة 

enter تصبح النافذة البيضاء على كبر الشاشة ويكبر ما بداخلها.

:وبالنقر عليه تظهر الرسالة التالية :  Scaleخيار -ه

Enter a scale factor (nX or nXp) :  , وعند كتابة رقم ,حيث تسأل عن معامل التكبير
ن ويمك,يكبر الشكل وعند كتابة رقم اصغر من واحد يصغر الشكل حسب المعامل 1اكبر من 

:اجراء هذه العملية بثلاث طرق يوفرها البرنامج وهي 
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 Zoomتتمة امر _ 

.مثلا يظهر الشكل بضعف الحجم الاول 2بكتابة الرقم 1.

اد منها أي ان هذه الطريقة يستف)يصار الى تكبير الشكل المكبر الى الضعف مرة ثانية  2xبكتابة 2.
فتجري العملية على الشكل الاصلي xاما كتابة الرقم المجرد بدون الحرف ,( للتعامل مع الشكل الجديد

.وليس الشكل الجديد 

.تتم العملية حسب ابعاد الورقة  2Xpعند كتابة 3.

نحدد مكان مركز الدائرة ,أي رسم دائرة وهمية وذلك بعد النقر على هذا الخيار :  Centerخيار-و
.الوهمية ونصف قطرها بحيث تضم الجزء المراد تكبيره على كبر الشاشة 

.للتكبير الى الضعف :        Inخيار -ز

.للتصغير الى النصف :     Outخيار -ح

اصبحت هذه فإن كانت ابعاد اللوحة اكبر,يقوم بعملية التكبير على كبر الشاشة للأكبر :      Allخيار -ط
كبر اما اذا كانت ابعاد الشكل هي الاكبر اصبحت ابعاد الشكل على,الابعاد على كبر واجهة الرسم 

.اما الخيار الاخير ,الواجهة 

عاد اللوحة فيقوم بتكبير الشكل المرسوم وجعله على كبر الشاشة بغض النظر عن اب: Extentsخيار -ي
.
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المطلوب ؟,الشكل الصغير على اليسار: س 

.الشكل اعلى اليمين.مرة 1.5تكبيره -1
.  الشكل اسفل اليمين.مرة اخرى 1.5تكبيره -2

108

اختبار ذاتي



:الحل 

◊◊◊◊◊◊

أو من شريط الادوات الرئيس ي , Viewفي القائمة  Zoomفي القائمة الفرعية Scaleبعد النقر على خيار 1)
.

:وذلك , وتسأل عن معامل التكبير ,Enter a scale factor (nX  or nXP ):   تظهر الرسالة 2)

.فانه سيكون معامل للتصغير 1اذا ادرجنا رقم اصغر من -أ

مرة 1.5في ها السؤال المطلوب تكبير الشكل ,فانه سيكون معامل للتكبير 1اذا ادرجنا رقم اكبر من -ب
.في شريط الاوامر 1.5لذلك نكتب ,

فان الشكل Xبدون 1.5في حين لو كتبنا ,(1.5X)مرة اخرى يجب كتابة 1.5لتكبير الشكل الجديد -ج
.الجديد لايكبر 
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: Panامر الازاحة  _ 

 توي على ويستفاد منه لتحريك نافذة الرؤية وليس الرسم ويح,وهو من الاوامر البسيطة سهلة الاستخدام
:عدة خيارات هي 

.1Realtime  :ك نافذة وفيه يتحول المؤشر الى شكل يد وبالضغط على الماوس مع تحريكه يتم تحري
. escاومفتاح  enterالرؤية وللخروج من الامر ينقر على مفتاح 

.2Point       : لتحديد نقطة معلومة اخرى للرؤية.

.3Left         : ازاحة لليسار.

.4Right      : ازاحة الشكل الى اليمين.

.5Up          : ازاحة الى الاعلى.

.6Down     : ازاحة الى الاسفل.
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الابعاد والكتابة:الفصل الخامس 

     الخامسة : الوحدة التدريبية.

            وضع الابعاد :الموضوعdimension , والكتابةText .

            المهندس نوري موس ى عبد : اسم المعد.

       النظرة الشاملة:

.طلاب الصف الاول -الفئة المستهدفة      -أ

ات يتوجب ادراج ابعاد اجزائه وبعض العبار ,لإتمام الفائدة من الرسم -مبررات الوحدة     -ب
.التوضيحية احيانا 

.طرق ادراج الابعاد أو كتابة ما مع الرسم -الفكرة المركزية    -ج

بةسيكون الطالب قادرا على تعلم طرق متعددة لإدراج الابعاد والكتا-اهداف الوحدة      -د
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 يوفر برنامجAuto CAD  امكانية اضافة:

.الابعاد والكتابة الى الشكل -أ

.لايمكن اضافة الابعاد والكتابة الى الشكل -ب
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.  Dimensionالابعاد _ :الموضوع

. Textالكتابة _ 

  الابعادDimension :
ريق كما يمكن الوصول الى خياراتها عن ط,يمكن وضع الابعاد في المستند  dimensionباستخدام القائمة 
:وتحتوي على عدة رموز منها ,شريط الرموز 

.ويكتب المسافات الافقية والعمودية :   Linearخيار ➢

.للمسافات المائلة :          Alignedخيار ➢

➢Ordinate              : الاحداثي السيني والصادي.

➢Radius                : نصف قطر دائرة أو قوس.

➢Diameter             : القطر.

➢Angular       : أو بالنقر على ,ويقيس الزوايا بإختيار الخط الاول ثم الثانيenter  ثم تحديد رأس
.الزاوية ثم الخط الاول ثم الثاني 

➢Continue     : وذلك باستخدام خيار ,ويستخدم عند وجود ابعاد كثيرة متجاورةlinear اوaligned

 واحد  Continueثم استخدام خيار , أولا 
ً
.لاستكمال كتابة باقي الابعاد المجاورة بعد تحديدها واحدا
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تتمة اوامر الابعاد_ 

➢Baseline    : ة الاولى والنقط,ويستخدم لكتابة الابعاد بين نقطة اساسية اولى والنقطة الثالثة
 linearولكن بعد كتابة البعد بين النقطة الاولى والثانية باستخدام امر  ,والرابعة وهكذا 

.  baselineثم تنفيذ امر ,في الخطوة الاولى  alignedاو

➢Quick dimension   : ي وتستخدم بكثرة ف,وهو من اقوى ادوات الابعاد الموجودة في البرنامج
 واحد أو بفتح نافذة متقطعة ,وضع اكثر من بعد في خطوة واحدة 

ً
نقر على ثم ال,وذلك بتحديدها واحدا

enter, ثم تحديد مكان كتابة الابعاد.
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:1ملاحظة 

:تغيير حجم كتابة الابعاد 

 )اذا ظهرت الابعاد بحجم غير مناسب 
ً
 مثلا

ً
:ة بإحدى الطرق الاتي,يمكن تكبيرها ,(صغيرة جدا

. enterثم النقر على dبكتابة حرف -أ

.  format  :Format→Dimension styleقائمة -ب

.       dimension   :Dimension→styleقائمة -ج

يحتوي على عدة خيارات في  Dimension Style Managerيظهر مربع حوار باسم  1)
. Modifyاليمين ننقر على خيار 

يحوي عدة خيارات اعلاه  Modify Dimension Styleيظهر مربع حوار اخر باسم  2)
,  OKثم ننقر على  ,نكتب حجم الابعاد المناسب  Text heightوفي خانة  , Textنختار 

.فيختفي مربع الحوار 

,     Closeننقر على , Dimension Style Managerويعاود مربع الحوار السابق  3)
.   فيظهر البعد بكتابة اكبر حجما يمكن قارئتها بسهولة 
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:2ملاحظة 

 وهي ,في الابعاد السابقة ظهرت ثلاثة خيارات مهمة :

❖Angle  : لتحديد زاوية ميل النص عن الخط الافقي حسبما تم تحديده.

❖Text   : لإدراج كتابة أو رقم اخر بدل القيمة الحقيقية.

❖MText : د فيتم اما اذا اردنا ان نكتب تحت خط البع,(الوحدات مثلا )بإدراج كتابة مع البعد قبله أو بعده
ثم الكتابة المطلوبة  فتظهر  <  >بعد القوسين (   Capital  Xخط مائل وحرف )\Xبواسطة كتابة 
:بالشكل التالي 
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وقد كتبت الابعاد باستخدام                  ,وحدة 400الشكل يمثل خط مستقيم طوله : س 

ارسم المستقيم وثبت ابعاده ؟. Mtextالخيار 
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:الحل 

◊◊◊◊◊◊

.Dimensionفي قائمة Linerلإدراج الابعاد امسافة افقية ننقر على خيار 1)

.ننقر على نقطة نهاية المستقيم في طرفه , …Specify first extension line: تظهر الرسالة 2)

.ننقر على نهاية الطرف الاخر ,…Specify second extension line: تظهر الرسالة 3)

في شريط الاوامر ثم النقر على مفتاح mبكتابة حرف  Mtextتظهر رسالة نختار منها الخيار الفرعي 4)
enter.

:وفيه , Multiline Text Editorيظهر مربع الحوار 5)

قد كتب بين 400وكأن الرقم , < >مثلا وأي كلمة اخرى بعد القوسين mmنكتب الوحدات -أ
.القوسين

ثم نكتب الكلمة المطلوبة وهي ,(X\)اذا كانت هناك كتابة تحت الخط يمكن ادراجها بكتابة -ب
(Length) , ثم النقر علىOK .
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: Textامر الكتابة  •

:وهما  Drawيمكن الوصول اليهما عن طريق قائمة ,هناك طريقتان للكتابة 

:التي تنفذ ,  Single line textالطريقة الاولى باستخدام خيار 1)

.  Draw  :Draw→Text→Single line textاما من قائمة  -أ

. enterفي شريط الاوامر ثم النقر على  Dtاوبكتابة -ب

.في هذا الخيار يكون كل سطر من سطور الكتابة عنصر واحد لوحده

.10x10كتابة عدة سطور بمواصفات مختلفة في مستند ابعاده :تطبيق 

.A 10فتح مستند جديد ابعادهx10 بالخطوات التالية:

▪Format →Drawing limits  

.0,0تحديد الركن الاسفل ▪

.10,10تحديد الركن الاعلى ▪

. enterثم ننقر  zكتابة حرف ▪

. enterثم ننقر  aكتابة حرف ▪
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:تتمة -

.B من قائمة  ( …وحجمه ولونه ,نوع الخط )تحديد مواصفات الكتابةFormat :

-Format →Text style   وفيه ,يظهر مربع الحوار:

(.مثلا  Verdana) يختار نوع الخط   Font Nameمن خانة  -أ

(.مثلا   0.0000)  لتحديد حجم الكتابة        Heightمن خانة  -ب

وبذلك تم تحديد المواصفات ,يختفي المربع  Closeثم ننقر زر          Applyننقر زر   -ج
.للكتابة اللاحقة 

.C نتبع الخطوات التالية ,للبدء بالكتابة:

تظهر رسالة تطلب تحديد , Draw  :Draw →Text →Single line textمن قائمة -أ
.نقطة بداية الكتابة 

سأل عن  تظهر الرسالة ت,تحدد نقطة البداية بالماوس أو بكتابة الاحداثيات في شريط الاوامر -ب
.حجم حروف الكتابة فيكتب الاختيار المناسب لنوع الخط والحاجة  

ختيار فأن وافقنا على الا ,تظهر الرسالة الثالثة وتطلب زاوية دوران السطر عن الخط الافقي -ج

كي  وإلا نكتب الزاوية المطلوبة  ل,لتكون الكتابة افقية  enterننقر على  < 0 >الافتراض ي 
.  تظهر الكتابة بسطر مائل بقيمة الزاوية المدرجة 
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تتمة -

. Enterوبعد إكمالها ننقر على زر ,فنبدأ الكتابة  Enter textتظهر الرسالة  -د

----

ولكن بحجم الحروف المطلوب( ب)نتبع الخطوتين ,(مثلا  0.4000)لكتابة سطر اخر ذو خط اكبر -ه
.فتبقى كما هي ( ج)اما الخطوة ,( 0.4000) وهو 

بطريقتين يؤجل  ويتم,احيانا يراد العودة الى مستند بعينه لتطبيق نفس مواصفته في الكتابة اللاحقة -و
.  شرحه 
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تتمة -

:وذلك بإتباع الاتي ,   Multiline textالطريقة الثانية باستخدام خيار 2)

.  Draw  :Draw →Text →Multiline textمن قائمة  -أ

(.بالنقر عليه )Aمن الرمز , drawمن شريط الرموز -ب

. Enterفي شريط الاوامر ثم ننقر على Tبكتابة حرف -ج

يظهر  مربع ,ها وتكون على شكل مستطيل تكون الكتابة بداخل,وبعد تحديد ركني النافذة الاول والثاني 

يمكن اختيار  نوع الخط  Characterومن خيار  Multiline Text Editorالحوار
تظهر ,    OKوبعد اتمام الكتابة والنقر على ,ولون الكتابة وفعاليات اخرى كإدخال الرموز 
.الكتابة داخل النافذة التي تم تحديدها أولا 
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:ملاحظة -

:  ذلك,يمكن ادراج رمز مع الكتابة  Symbolومن خيار , Multiline Text Editorفي مربع الحوار  

ب ينقر على الرمز المطلو ,تظهر قائمة تحتوي على رموز ظاهرة  symbolبعد ان ننقر على خيار  1)
.فيتم كتابته مع النص 

بالنقر عليه يظهر مربع حوار بإسم    Otherهنالك عدد كبير اخر من الرموز في خيار 2)
Character Map,نتبع الاتي ,ولإدراج أي رمز:

.نختار الرمز بالنقر عليه -أ

. Selectننقر على خيار -ب

.  Copyننقر على خيار -ج

فيتم ادراج الرمز  , Pasteتظهر قائمة ننقر على خيار ,ننتقل الى نافذة الكتابة وننقر باليمين -د
. المختار 
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Status Barشريط الحالة  :الفصل السادس 

   السادسة : الوحدة التدريبية.

          (. شريط الادوات المساعدة للرسم الدقيق )شريط الحالة : الموضوع

          المهندس نوري موس ى عبد : اسم المعد.

     النظرة الشاملة:

.طلاب الصف الاول : الفئة المستهدفة   -أ

, يوفر هذا الشريط عدد من الخيارات استخدامها يؤدي الى رسم ادق : مبررات الوحدة  -ب
.وبطرق اسهل ,بوقت اقصر 

.كيفية استخدام خيارات هذا الشريط : الفكرة المركزية -ج

.  ر سيكون الطالب قادرا على تنفيذ الاوامر المتاحة في الشريط بيس: اهداف الوحدة   -د
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 شريط الحالة يحتوي على مجموعة من الاوامر تؤدي الى:

.تنفيذ الرسم بطريقة مطولة -أ

.تنفيذ الرسم بيسر ودقة -ب

.تنفيذ الرسم عشوائيا -ج

125

الاختبار القبلي 



:الموضوع 

  خاصيتيGrid (F7)    ,Snap(F9):

اما خاصية ,لإظهار شبكة من النقاط على الواجهة على مسافات معينة  Gridتستخدم خاصية  1)
Snap فتستخدم للقفز بمقدار معين افقيا أو عموديا.

:وذلك بطريقتين , Spanو  Gridيمكن تفعيل خاصيتي 2)

.يلغى العمل  بها وبالنقر عليها مرة ثانية,في الشريط اسفل الواجهة ,بالنقر على الخاصية المطلوبة -أ

في لوحة F9من مفتاح Snapوخاصية F7من مفتاح  Gridكما يمكن تنشيط خاصية -ب
.بنفس الوقت G+Ctrlبالضغط على مفتاحي   Gridكما يمكن تفعيل خاصية ,المفاتيح 

وتحديد مقدار , Gridيمكن تحديد المسافة الفاصلة العمودية بين نقاط الشبكة والأفقية في خاصية 3)
الذي Drafting Settingsوذلك من مربع الحوار  Snapالمسافة التي يقفزها المؤشر في خاصية 
:يمكن الوصول اليه من مكانين وهما 

→ Tools  :Toolsمن قائمة  -أ Drafting settings 

Settingsثم النقر على خيار  SnapاوGridبالنقر باليمين على أي من خاصيتي -ب

:وباستخدام أي الطريقتين يظهر مربع الحوار المذكور وفيه,
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 Draftingمربع الحوار -تتمة

Settings

.A تحديد المسافات الافقية بين النقاط يتم من خانةX Spacing فتتبعها المسافة العمودية بنفس
. Y Spacingفتحدد من خانة ,اما اذا كانت المسافة العمودية مغايرة , القيمة 

.B من خانةAngle , ه اما اذا كتبت زاوية في هذ,تظهر النقاط متعامدة افقيا وعموديا 0اذا كانت الزاوية
يني  والنقاط عن المحور الس(نفس الزاوية التي كتبت )الخانة فان نقاط الخط الافقي تظهر مائلة بزاوية 

.العمودية مائلة عن المحور الصادي 

.C من خانةX base وخانةY base فان المؤشر يبدأ القفز من   0فلو كانت ,يتم تحديد بداية القفز
هذا )وهكذا  35←25←15←5فان المؤشر يبدأ من 5اما اذا كانت ,وهكذا 30←20←10←0

(.10عندما تكون مسافة القفز قد حددت 

.D  من خانةSnap type&style تحدد طريقة قفز المؤشر وهي:

.يقفز عليها المؤشر,وفيه خطوط النقاط متعامدة افقيا وعموديا  Rectangle snap-أ

.°120وفيه الزاوية بين الخطوط   Isometric snap-ب

 polarوفيها يتم القفز على الزاوية التي يتم تحديدها في خاصية          Polar snap-ج

 polar spacingوبمسافة يتم تحديدها من 
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:ملاحظات

.ان نقاط الشبكة لاتظهر في الطباعة ❑

الى .Y Spaتتغير القيمة تلقائيا في X Spacingعند تغيير قيمة …Drafting settingsفي مربع الحوار ❑
, OKيجب ان نكتب القيمة المطلوبة ثم ننقر yلذلك لتغيير قيمة ,ولكن العكس ليس صحيحا .نفس القيمة 

فيغلق المربع وتكون OKمرة اخرى ثم ننقر على Xيجب كتابة قيمة Xالتي تساوي قيمة Yوللعودة الى قيمة 
.المكتوبة انفا Xقد تغيرت الى قيمة Yقيمة 

ار نقاط الشبكة عند اختيار المسافة بين نقاط الشبكة صغيرة جدا بالنسبة لأبعاد  الواجهة قيد العمل يتعذر اظه❑

ا وتعني ان المسافات بين نقاط الشبكة صغيرة جد, Grid too dense to displayوتظهر الرسالة التالية 
. بحيث يستحيل اظهارها 
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:  Polar(F10) &Ortho(F8)خاصيتي  -

اشمل حيث Polarيعتبر نظام  ,لرسم خطوط افقية وعمودية فقط Orthoففي حين يستخدم ,وهما خياران متشابهان 
:ويمكن استخدام هذا الخيار كما يأتي ,( °45الشائع الزاوية )يرسم خطوط على الزاوية المحددة ومضاعفاتها 

لى أو عن طريق الضغط ع,اسفل الشاشة لتفعيله وعند نقره مرة اخرى يلغى التفعيل Polarالنقر على خيار -أ
.في لوحة المفاتيح F10مفتاح 

والنقر على خيار  Drafting settingsفيظهر مربع الحوار  settingsالنقر على الخيار باليمين واختيار -ب
Polar tracking, والذي يمكن الوصول اليه من قائمةTools , وفيه:

.نختار قيمة الزاوية التي سيتم الرسم عليها وعلى مضاعفاتها increment anglesمن خيار 1)

. Track using all polar angle settingsيثبت خيار 2)

.   Absoluteيثبت خيار 3)
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, وحدة 100وطول الخط 100,100ارسم الشكل مع العلم ان إحداثيات المركز : س 
؟°45والزاوية 
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:الحل 

◊◊◊◊◊◊

.اسفل الشاشة لتفعيله Polarننقر على خيار 1.

.يظهر مربع الحوار ,Settingsباليمين ونختارPolarننقر على خيار 2.

. OKثم ننقر°45نختار قيمة الزاوية 3.

.100,100نرسم خط ونقطة البداية 4.

في شريط الاوامر (طول المستقيم)50النقطة الثانية نقترب من الخط الافقي فيظهر خط منقط فنكتب 5.
.وحدة 50فيرسم البرنامج خط افقي طوله 

.45ة وننقره مرة ثانية للعودة اليه لرسم الخط الثاني بزاوي,للخروج من الامرEnterننقر على مفتاح 6.

يظهر 45ثم نحرك الماوس وعند الوصول الى الزاوية  ,100,100لرسم الخط الاخر ندخل النقطة الاولى 7.
مها وهكذا مع بقية الخطوط لرس,في شريط الاوامر فيرسم الخط الثاني50الخط المنقط فنكتب الطول 

.
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: Object snap OSNAP(F3)خاصية -

 تستخدم هذه الخاصية لقفز المؤشر الى مكان معين تم تفعيله سابقا من مربعDrafting settings… , ويتم
في المربع المذكور وتفعيل الخيارObject snapتفعيل الخيارات الموجودة التي تظهر بعد اختيار الخيار الرئيس ي 

فيختفي مربع  OKفي مربعه ثم النقر على (صح)المطلوب ان نرسم بموجبه وذلك بالنقر عليه فتظهر علامة 
في لوحة المفاتيح  F3بالنقر عليه اسفل الشاشة أو من خلال مفتاح  OSNAPويجب ان يفعل خيار .الحوار 

:وتحتوي هذه الخاصية على خيارات كثيرة وهي ,(صح)أو بالنقر عليه في مربع الحوار بإظهار علامة ,

-End point نهاية الخط اوالقوس  .-Quadrant نقاط التقاطع معXاوY.-Perpendicular
عمودي 

-Mid point منتصف الخط   .-Intersection نقاط التقاطع  .-Parallel في رسم خطوط موازية

-Center    المركز            .-Extension        على امتداد-Tangent نقاط التماس

-Node       نقاط مرسومة بأمرpoint–Insertion  نقاط الادراج–Nearest اقرب نقطة على
شكل 

-Apparent وهي على شكلين:

-Apparent  intersection في ,س وهي نقطة تظهر في المسقط الافقي وكأنها نقطة تقاطع خطين أو خط وقو
.أي انهما لايتقاطعان فعليا ً ,حين ان العنصرين كلٌ في مستوٍ 

-Extend apparent intersection وهي نقطة تقاطع امتداد الخطين.
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نفذ المطالب اللاحقة؟: س 

 دائرة وخطان متقاطعان , في الشكل اعلاه:

. Extension, Intersection, Center, End pointتم تفعيل الخيارات ◦

.OSNAPكما تم تفعيل الخيار ◦
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ارسم دائرة جديدة لها نفس مركز الدائرة الموجودة بنصف قطر معلوم ؟-1

: الحل 

. Drawننقر على رمز دائرة في شريط الرموز 1)

شكل على)وبمجرد الاقتراب من الدائرة المرسومة تظهر علامة ,يسأل البرنامج عن مركز الدائرة 2)

وعند النقر على الماوس في أي مكان يعرف البرنامجcenterفي مركز الدائرة وكلمة (دائرة صغيرة 
.ان مركز الدائرة المطلوب رسمها هو نفس مركز الدائرة الموجودة 

ائرة فيتم رسم د,يسأل البرنامج عن نصف قطر الدائرة الجديدة فنكتبه في شريط الاوامر 3)

.جديدة مركزها نفس مركز الدائرة الموجودة اصلا بصف قطر معلوم 
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ارسم خط بين نهايتي الخطين المتقاطعين في الشكل ؟-2

:الحل 

. drawالموجود في شريط الرموز Lineننقر على امر 1)

هر مربع  وعند الاقتراب من نهاية احد المستقيمين يظ,يسأل البرنامج عن النقطة الاولى للخط 2)

.فيكون قد تم تحديد النقطة الاولى للخط ,ننقر على الماوس ,Endpointعندها وكلمة 

تظهر نفس ,وعند الاقتراب من نهاية المستقيم الثاني ,يسأل البرنامج عن النقطة الثانية للخط 3)
ويتم رسم الخط المطلوب,العلامة ننقر الماوس ونكون قد حددنا النقطة الثانية للخط 
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وركنه الثاني منتصف الخط الاطول ؟,ارسم مستطيل  ركنه الاول نقطة تقاطع الخطين -3

:  الحل 

. rectangleننقر على رمز 1)

ة نقترب من نقطة تقاطع الخطين تظهر علامة وكتاب,تظهر رسالة تسأل عن الركن الاول 2)

Intersection, ننقر على الماوس.

ار وهنا يجب ملاحظة اننا لم نفعّل خي,تظهر رسالة تسأل عن الركن الثاني للمستطيل 3)

Midpoint  ولانجاز هذه الخطوة نرجع الى مربع الحوار ,ولذلك يجب تفعيلهDrafting 

settings ونفعّل خيارMidpoint  ولذلك يفضل استخدام طريقة,ولكن هذه طريقة طويلة
.اخرى مبينة في الملاحظة اللاحقة 
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: ملاحظة  ❑
ولكن لاستخدامه مرة  OSNAPأو خيار اخر من خيارات  Midpointهنالك طريقة اخرى لتفعيل الخيار 

فتظهر قائمة تحتوي على ,وعلى يمين الماوس  Shiftوهي الضغط بنفس الوقت على مفتاح ,واحدة فقط 
ثم يلغى تفعيله لمرة واحدة فقطفيفعّل هذا الخيار  Midpointننقر على خيار ,جميع الخيارات 

(.وكذلك لباقي الخيارات)اوتوماتيكيا بعد استخدامه لمرة واحدة 
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وحدة افقيا على يمين الدائرة الموجودة في 100وحدة يبعد مركزها بمقدار30ارسم دائرة جديدة نصف قطرها -4

الرسم ؟

:الحل 

.ننقر على رمز الدائرة 1)

لذلك ,غير موجود في مربع الحوار  Fromتظهر رسالة تطلب إحداثيات المركز ولكن خيار 2)
:وهي ,تستخدم الطريقة التي وردت في الملاحظة السابقة 

على ننقر,تظهر قائمة الخيارات ,وعلى يمين الماوس بنفس الوقت  shiftنضغط على مفتاح -أ
Form .

أي اننا )ننقر على مركز الدائرة الموجودة , from base point:تظهر الرسالة التالية -ب
وهي  base pointنريد رسم عنصر جديد وهو الدائرة يبعد مركزها عن نقطة اساسية 

.مركز الدائرة الموجودة في السؤال 

تطلب مكان المركز للدائرة  <Offset>وبعد النقر على المركز تكمل الرسالة بكلمة -ج
وحدة من مركز 100أي انه بمسافة افقية الى اليمين بمقدار ) 100,0@نكتب ,الجديدة 
.ونكون قد حددنا مركز الدائرة المطلوبة ( الدائرة 

.فيتم رسم الدائرة المطلوبة,30تظهر رسالة تطلب قيمة نصف القطر نكتب 3)
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(.تمرين للحل )ارسم خط من نقطة التقاطع يكون مماسا للدائرة -5
30صف قطرها علما ان ن, الخطين امتدادالمطلوب رسم دائرة مركزها نقطة تقاطع , في الشكل الاسفل مستقيمين -6

.وحدة 

: الحل 

.Intersection ,Extension,Endpointفي هذا المثال نحتاج الى تفعيل الخيارات 1)
.ننقر على رمز الدائرة فيطلب البرنامج تحديد مركز الدائرة2)

.Endpointنقترب من نهاية احد المستقيمين تظهر علامة و-أ3)

-جExtensionنحرك الماوس بجهة امتداد المستقيم الاول الى مسافة ما يظهرخط منقط وكتابة -ب
.للمستقيم الثاني End pointنترك الخط الاول ونقترب من نهاية الخط الثاني تظهر علامة 

ونستمر ( أي امتداد الخط الثاني)Extensionنحرك الماوس على امتداد المستقيم الثاني تظهر علامة -د
.وبة بتحريك الماوس الى ان يظهر امتداد الخطان متقاطعان في نقطة وتمثل مركز الدائرة المطل

.فترسم الدائرة,30تظهر رسالة تطلب نصف القطر نكتب 4)
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:  OTRACK(F11)خاصية -

 كلمةTRACK طة معينة تعني درب أو مسار أو طريق وهمي يوفره البرنامج يستخدم للوصول الى نق
. polarو object snapوتعتبر هذه الخاصية تركيب لخاصيتي ,
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نفذ المطالب اللاحقة ؟,في الشكل ادناه : س 
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وحدة ؟35ونصف قطرها °45ارسم دائرة مركزها على امتداد مركزي الدائرتين المتماستين على زاوية -1

:الحل 

.°45نثبت قيمة الزاوية , polarفي الخاصية 1)

كما نفعّل . Intersection, Extension, Centerوالخيارات الفرعية OSNAPنفعّل الخيار 2)
. Polarلكي تظهر المسارات التي تم تحديدها في  OTRACKخيار 

:فنتبع الخطوات التالية ,ننقر على رمز الدائرة فيطلب البرنامج تحديد مكان مركز الدائرة 3)

يظهر المسار ,45نقترب من الدائرة على اليسار فيظهر المركز نقف عليه ونتحرك على مسار قرب زاوية -أ
ونحرك المؤشر مسافة ما,(45خط منقط وكتابة تظهر الطول والزاوية )

حتى نصل °135نقترب من الدائرة الثانية ونقف على المركز ثم نتحرك بإتجاه مسار يظهر على الزاوية -ب
ركز أي اننا حددنا مكان م)فيظهر خطان منقطان متقاطعان ننقر على الماوس ,الى نقطة التقاطع 
(.الدائرة المطلوبة 

.فترسم الدائرة المطلوبة ,35نكتب ,تظهر رسالة تسأل عن نصف القطر -ج
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رى من ارسم دائرة مركزها نقطة تقاطع امتداد الخط الافقي مع الامتداد العمودي لمركز الدائرة اليس-2

الدائرتين المتماستين ؟

:الحل 

م تحريك ثم الاقتراب من الدائرة ونقف على مركزها ث,وذلك بالنقر على امر دائرة ,يحل بنفس الخطوات 
تم اظهار ثم من نقطة نهاية المستقيم القريبة للدائرة ي,الماوس على المسار العمودي مسافة ما 

كتب قيمة والنقر عليها فيحدد مكان المركز ثم  ن,المسار الافقي الى ان يتم اظهار نقطة التقاطع 

.فترسم الدائرة المطلوبة ,35نصف القطر 
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ونصف ( قبله)20ارسم دائرة مركزها على امتداد المسار العمودي للدائرة الثالثة ولكنها تبعد عن الخط بمسافة -3

وحدات ؟10قطرها 

:الحل 

.وننقر على امر دائرة , OTRACK,OSNAPالخيارين تفعيل1)

:تحديد مكان المركز 2)

 الى نقترب من الدائرة تظهر علامة المركز فنقف عليه ونحرك الماوس على المسار العمودي وصولا-أ
ولكن ,قطةفإذا نقرنا عليها ترسم الدائرة ومركزها هذه الن,المستقيم الافقي فتظهر نقطة التقاطع 

fromولذلك يجب تفعيل خيار ,وحدة قبل الخط الافقي 20الدائرة المطلوبة يجب ان ترسم على بعد 

وهو مركز 20-,0@ثم نكتب (base point)نحدد نقطة التقاطع لتمثل ,fromبعد تفعيل خيار -ب
.الدائرة 

.فترسم الدائرة المطلوبة ,نكتب قيمة نصف القطر -ج
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رسم المنظور والمساقط :الفصل السابع 

    السابعة : الوحدة التدريبية.

           المساقط –رسم المنظور : الموضوع.

           المهندس نوري موس ى عبد : اسم المعد.

      النظرة الشاملة  :

.طلاب الصف الاول : الفئة المستهدفة     -أ

.رسم المنظور والمساقط يعطي فكرة كاملة عن الجسم : مبررات الوحدة    -ب

.ورسم مساقطه ,طريقة رسم المنظور لجسم : الفكرة المركزية   -ج

.سيكون الطالب قادرا على استخراج شكل المنظور ورسم مساقطه : اهداف الحدة       -د
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 المنظور والمساقط تؤدي الى : س:

.بينما المساقط ترسمها بأبعادها الحقيقية , المنظور يرسم الاشياء بأبعاد غير حقيقية -أ

.المنظور والمساقط يرسم الاشياء بابعادها الحقيقية -ب

.المنظور والمساقط كلاهما لا يرسم الاشياء بالابعاد الحقيقية -ج
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:الموضوع 

 المنظور والمساقط:

نظور يرسم ففي رسم الم, لا كحقيقتها ( أي كما تراها العين ) المنظور هو رسم الاشياء رسما فوتوغرافيا 
وكذلك . ضا وزواياه متساوية اي, المربع شكلا رباعيا مختلف الاضلاع والزوايا في حين ان اضلاعه متساوية 

غيرا حيث ان الجزء القريب يرسم كبيرا والبعيد يرسم ص, الحال مع جميع الاجسام عند رسمها منظوريا
. والمسافات المتساوية مختلفة 

يين ومصممين اما رسم المساقط فانه ضروري للعاملين في المجالات الهندسية من مهندسين وحرفيين وفن
لمساقط سهلة وهذا البرنامج يوفر طرق لرسم المنظور وا, وذلك انه يبين الابعاد الحقيقية للأوجه المختلفة 

.  كما سنلاحظ في التطبيق اللاحق , ودقيقة بوقت قصير
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:علما ان, ارسم منظور الشكل ادناه ومساقطه : س 
.وحدة20وبسمك ( مثلا)المستطيل باللون الاصفر-1

.وحدة40الدائرة باللون الاحمر وبسمك -2

148

اختبار ذاتي



:الحل 

.A نرسم المستطيل والدائرة بابعاد عشوائية ليكون الشكل مشابه.

.B نتبع الاتي (20اللون اصفر والسمك )لكي يكتسب المستطيل الخواص المحددة:

.فيظهر بخطوط منقطة ,نحدد المستطيل بالنقر عليه -أ

وفيه  Propertiesيظهر مربع حوار بعنوان , Modifyفي قائمة  Propertiesننقر على خيار -ب
ويحتوي مربع الحوار على خيارات ,أي انه قد تم تحديد المستطيل Polylineيظهر اسم العنصر 

:مايهمنا في هذا المثال اللون والسمك ,متعددة 

ى يمين فيظهر المثلث الصغير عل,ننقر عليه أي اننا نريد اختيار لون معين  Colorخيار اللون 1)
Bylayer  ل نختار اللون الاصفر بالنقر عليه ويتحو ,فتظهر قائمة الالوان ,ننقر عليه

.المستطيل المنقط الى اللون الاصفر

في هذا الخيار 20وبالنقر عليه وفي الجهة اليمين نكتب السمك Thicknessمن خيار السمك 2)
.0بدلا من 

.في المربع الاحمر xبالنقر على ,نخرج من مربع الحوار 3)

.الاولى للخروج من التحديد والثانية للخروج من الامر,مرتين Escننقر على مفتاح 4)

.C ولكن باختيار اللون ,بإتباع نفس الخطوات( 40اللون الاحمر والسمك )لتكتسب الدائرة المواصفات المحددة
.20بدلا من40وسمك ,الاحمر بدل اللون الاصفر 
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( :تتمة)اظهار منظور الشكل ومساقطه -

.D قطه الثلاثة وإظهار مسا,(أي لتحويل الشكل من ثنائي الابعاد الى ثلاثي)لإظهار الشكل ثلاثي الابعاد

: Viewنستخدم قائمة ,بأمر واحدSideوالجانبي  Frontوالأمامي Topالعلوي  

View→View ports→Named view ports…                             

:New view portsيظهر مربع حوار ننقر على خيار  

New  view ports → Four : Equal                                          

(. 3Dيجب ان نختار  Setupفي خانة ) 

صفحة دفعة واحدة مباشرة كما في ال,بعد اتمام الخطوات اعلاه يظهر المنظور ومساقطه على الواجهة 
.التالية 

********************************
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وقد تم اظهارها دفعة ,(Right view)والجانبي (Front view)والأمامي (Top view)المنظور ومساقطه الثلاثة الرأس ي -
.واحدة بأمر واحد 
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:كلٌ بأمر, لإظهار المنظور والمساقط واحدا واحد -

:على خطوات وكما يلي ,كما يمكن اظهار المنظور أولا ثم المساقط 

:Viewيمكن اظهار المنظور فقط من قائمة  -أ

View → 3D view  فتظهر قائمة فرعية وبالنقر على أي من الخيارات الايزومترية الاتية
(NW,NE,SE,SW), كما هو الشكل ادناه ( أي المنظور )يظهر الشكل الثلاثي الابعاد.
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.اظهار المساقط واحدا تلو الاخر -

لاثة الاخرى احدها لعرض المنظور والث,للشكل نحتاج الى اربعة اماكن لعرضها لإظهار المساقط الثلاثة -ب

: Viewولتقسيم واجهة الرسم بهذا الشكل نعود الى قائمة ,لإظهار المساقط 

View → view ports → 4view ports                      

يظهر في ,اثنان في الصف الاعلى واثنان في الصف الاسفل ,فتقسم الواجهة الى اربعة اقسام متساوية 
.جميعها  المنظور السابق

:نتبع الخطوات التالية ,لإظهار المسقط الرأس ي في القسم اعلى اليسار-ج

بع على الماوس يظهر اطار سميك حول المر نسحب المؤشر الى مربع اعلى اليسار وننقر1)

لسابق اما في المربعات الاخرى فيرجع الى شكله ا,ويتغير شكل المؤشر في هذا المربع فقط 

.أي ان الخطوات اللاحقة تنفذ فيه فقط 

→ View  :Viewمن قائمة 2) 3D View → Top  , وبعد النقر على خيارTop يظهر
. المسقط الرأس ي في هذا المربع 

ربع ونختار نحدد هذا الم,لإظهار المسقطين الامامي في المربع اسفل اليسار نتبع نفس الخطوات 3)

Front  , والمسقط الجانبي في المربع اسفل اليمين نحدد هذا المربع ونختارRight أوLeft .
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.كما انها ادرجت في اماكن حسب الرغبة,المساقط الثلاثة وقد تم اظهارها الواحد تلو الاخر -
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:عندما تكون الاسطوانة على ارتفاع اخر 

 سطوانة يبدأ اما لو كان اسفل الا ,ظهر اسفل الاسطوانة في نفس مستوى اسفل الصندوق ,في الرسم السابق
,  وحدة 40( سمك)وكان ارتفاعها ,(وحدة20أي على ارتفاع , من اعلى سمك الصندوق مثلا)من نقطة اخرى 

:فكيف السبيل الى اظهارها 

:نتبع الخطوات التالية ,لم ترسم بعد اذا كانت الدائرة -أ

. enterثم ننقر على مفتاح ,في شريط الاوامر elevنكتب 1)

تسأل عن  , <specify new default elevation <0.0000:  تظهر الرسالة التالية2)
على محور 20أي انها تبدأ من الارتفاع  enterثم ننقر على 20فنكتب (البداية )مستوي الرسم 

Z.

تسأل عن قيمة ,  :< > Specify new default thickness: تظهر الرسالة التالية 3)
ثم ننقر على 40تب نك,(الارتفاع التي ستكون عليه الاسطوانة)المسافة التي ستنبثق بها الاسطوانة 

. enterمفتاح 

.ونتبع الخطوات السابقة الخاصة بالمستطيل ,نرسم الدائرة في المكان المطلوب4)
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:تتمة 

وحدة 20بمسافة zنلجأ الى تحريك الدائرة على محور ,مع المستطيل مرسومة سابقا اذا كانت الدائرة -ب
:وذلك بالخطوات التالية ,

. Modifyفي شريط   Moveالنقر على امر 1)

. enterنحدد الدائرة بالنقر عليها ثم النقر على  Select objectsتظهر الرسالة  2)

ننقر على النقر أو على أي , Specify base point or displacementتظهر الرسالة  3)
.نقطة على محيط الدائرة 

أي ,  enterثم ننقر على   0,0,20@نكتب   Specify second pointتظهر الرسالة 4)
اما لو كتب ,الى الاعلى 20بمسافة Zعلى المحور XYاننا حركنا مكان الاسطوانة من مستو  

.الى الاسفل 20لتحرك اسفل الاسطوانة بمسافة  20-,0,0@
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.وحدة 20الشكل وقد ظهر اسفل الاسطوانة على الارتفاع الجديد -
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التهشير ورسم المقاطع:الفصل الثامن 

       الثامنة : الوحدة التدريبية.

              رسم المقاطع –التهشير :الموضوع.

               المهندس نوري موس ى عبد :اسم المعد.

         النظرة الشاملة:

.طلاب الصف الاول :الفئة المستهدفة        -أ

, حددتستخدم عملية التهشير للدلالة على القطاعات بملئها بنوع م:مبررات الوحدة       -ب

.وذلك لتكون معلومات لوحة الرسم كاملة

.طرق تنفيذ عمليات التهشير :الفكرة المركزية      -ج

لمقاطع ورسم ا,سيكون الطالب قادرا على تنفيذ تهشير القطاع المطلوب:اهداف الوحدة        -د
.وتهشيرها 
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 عملية التهشير تهدف الى:

.اظهار الفجوات الموجودة داخل الجسم في مكان القطع وإظهارها بشكل واضح -أ

.عملية جمالية لافائدة منها -ب
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:الموضوع 

التهشير :
لالة على يستفاد من عملية التهشير للمض ي خطوة الى الامام لاكمال المعلومات عن لوحة الرسم للد

يجب ان و ,حيث يملئ القطاع بنموذج تهشير محدد يوفر البرنامج العديد من نماذجها ,القطاعات 
.وإلا لا ينفذ الامر , يكون المكان الذي يراد تهشيره مغلقا 

:باحدى الطرق التالية , Hatchويتم تشغيل امر التهشير 

→ Draw   :Drawمن قائمة  1. Hatch…      .

.بالنقر على رمز التهشير في شريط الرسم 2.

.في شريط الاوامر  hبكتابة حرف 3.

ويتم اختيار المكان الذي يراد تهشيره اما ,Boundary Hatchحيث يظهر مربع الحوار 
 pick pointأو باستخدام  ,بالنقر على حدود الشكل select objectsباستخدام خيار 

.وبذلك يتم تحديد مكان التهشير ,باختيار نقطة داخل الشكل والنقر فيها 

. Quick  ,Advancedويحتوي مربع الحوار اعلاه على خيارين رئيسين هما  
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:نفذ المطالب التالية , في الاشكال ادناه : س 
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:المطالب 

. (°45)بخطوط مائلة بزاوية ( 1)تهشير المستطيل 1)

:الحل

. Boundary Hatchفيظهر مربع الحوار ,ننقر على رمز التهشير -أ

ولاختيار نموذج   Swatchفيظهر شكل نموذج التهشير في خانة ,Quickالخيار الرئيس ي نختار -ب
 Hatch patternيظهر مربع اخر patternللتهشير ننقر على مربع النقاط الثلاثة في خانة  

palette   يحوي عدة خيارات رئيسية هيANSI, ISO, Other predefined  يحتوي كل منها
.على نماذج لشكل التهشير 

. OKثم ننقر(اساسا°45وهو يمثل خطوط مائلة بزاوية )ANSI31ننقر على   ANSIمن خيار -ج
,  Scaleومقياس رسم التهشير (Angle)هناك خياران اسفل لتحديد زاوية ميل التهشير :ملاحظة 

هشير غير حيث يظهر خط أو اثنان داخل المستطيل فيكون الت,حيث يستخدم لتغيير مقياس الرسم )

(.الى قيمة اصغر مناسبة1منScaleمما يستدعي تصغير مقياس الرسم من خانة ,واضح 

وننقر على أي نقطة من خطوط محيط  Select objectsنحدد مكان التهشير بواسطة خيار-د
والنقر في أي نقطة داخل المستطيل ثم النقر على  pick pointأو بواسطة خيار ,المستطيل 

enter, ننقر على ,فيظهر مربع الحوار مرة اخرىpreview  أو مباشرة على ,للمشاهدةOK 
.لتثبيت الاختيار النهائي 
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:Quickباستخدام خيار  , تتمة-

:تهشير الجزء المحصور بين الدائرتين 2)

:الحل 

والنقر على نقطة على select objectsفي الخطوة السابقة امكن تهشير المستطيل بأي من الخيارين  
.والنقر في نقطة داخل المستطيل  pick pointأو ,المحيط 

والنقر في نقطة داخل هذا  pick pointاما تهشير الجزء المحصور بين الدائرتين فيتم بواسطة خيار 
واتباع باقي ,لان محيطه ليس عنصرا واحدا  select objectsولايمكن تهشيره بخيار ,الجزء 

.الخطوات السابقة الاخرى في تهشير المستطيل 

:واحد تهشير اكثر من مكان بأمر واحد 3)

:الحل 

ضا لان المستطيل هو عنصر لوحده وتهشير مابين الدائرتين عنصر لوحده اييلاحظ ان تهشير
ا عن.تهشيرهما تم بخطوتين 

ّ
صرا واحدا  اما لو قمنا بتهشير مكانين بأمر واحد دفعة واحدة لكون

( 
ً
ما فيحدد كل فمثلا لمسح التهشير ننقر على احده,(أي ان الامر اللاحق ينفذ على المكانين سوية

فيتم مسحها Deleteمكانات التهشير التي نفذت دفعة واحدة بامر واحد ثم النقر على مفتاح 
كلها 
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: Advancedالتهشير بواسطة الخيار 

  بعد النقر على خيارAdvanced, تظهر الخيارات الرئيسية التاليةNormal, Outer, Ignore  ننقر
. على أي منها حسب الحاجة 

  ننقر مربعpick points  داخله ويعتبر العنصر الذي تم النقر,يختفي مربع الحوار ونختار مكان النقطة
:والخيارات الثلاثة اعلاه تعني .هو الاطار الخارجي للتهشير ولاينفذ تهشير خارجه 

(1Normal : ًمن العنصر عند النقر في نقطة في عنصر يعتبر العنصر الخارجي وينفذ التهشير ابتداء 
يهشر مابداخلها , 4عند النقر في الدائرة الخارجية رقم ,في الدوائر المتداخلة الاربعة )الخارجي وبالتناوب 

.1وتترك الدائرة 2ويهشر ما بداخل ,بلاتهشير3وتترك 

(2Outer    :ر يهشر داخل العنصر الخارجي فقط ويترك مابداخل العناصر الداخلية بدون تهشي
.بدون تهشير 3,2,1يهشر مابداخلها فقط ويترك ما بداخل الدوائر 4فعند النقر في الدائرة )

(3Ignore  : حيث يكون العنصر الذي تم تحديدpick point  فيه هو العنصر الخارجي ويهشر ما
ما مثلا يتم تهشير جميع ما بداخلها بدون استثناء ويترك3بداخله بالكامل فعند النقر داخل الدائرة 

.خارجها دون تهشير 
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الشكل بعد التهشير
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:وتهشيرها , (  Sectionالقطاعات ) رسم المقاطع -

الاعتيادية  بل بعض الاجسام وخصوصا الميكانيكية تحتوي على تجاويف داخلية لاتظهر في المساقط
.قد تشوش الرسم وتؤدي الى عدم فهم الرسم بسهولة ووضوح ,ترسم بخطوط متقطعة 

كة مما لذا فان رسم القطاع يوضح التجاويف والأجزاء الداخلية للجسم حيث يرسمها بخطوط سمي
.يسهل قراءة الرسم وفهمه 

 وعن تهشير الاجزاء المقطوعة في الجسم يتضح الرسم اكثر.
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:فيه تجويف , جسم مكون من صندوق متوازي مستطيلات : س 
.100وارتفاعه ,100وعرضه , 200طوله -

.30التجويف اسطواني نصف قطره -

.ارسم المقطعين , تم قطع الجسم عرضيا وطوليا -

:الحل 

على اليمين :على اليسار         المقطع الطولي :رسم المقطع العرض ي -

:نتبع التالي , بعد نقل نقطة الأصل الى مكان مناسب على الواجهة 

(.100,100)وركنه الثاني ( 0,0)نرسم مربع ركنه الاول 1.

يتم رسم المقطع العرض ي.30نرسم دائرة مركزها منتصف المربع ونصف قطرها 2.
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:لرسم المقطع الطولي 

لتصبح هي نقطة ,الى اليمين مثلا150بعد نقل المحاور الى نقطة على امتداد الخط الافقي بمسافة ◦
:نتبع الخطوات التالية ,الأصل الجديدة 

نرسم  خط يبدأ من نقطة الأصل , intersection, otrack, polarبعد تفعيل : رسم المستطيل 1)
ثم الخط الافقي الاعلى بطول ,100ثم الخط العمودي بطول ,بالاتجاه الافقي 200بطول (0,0)

.100وأخيرا الخط العمودي على اليسار بطول ,200

اسفل الخط الافقي الاعلى 20لرسمهما على مسافة Offsetنستخدم امر ,لرسم خطي الاسطوانة 2)
.وفي الجهة الاعلى للمستقيم الاسفل من المستطيل ,للمستطيل 

فلا يمكن رسم الاسطوانة كما سبق ,(  rectangleامر )اما لو كان المستطيل قد رسم بأمر واحد 
وتوجد عدة طرق اخرى لرسمها منها رسم خطي (. explodeبأمر )إلا بعد تفجير المستطيل 

ورسم الخطان  Quadrant, Intersectionالاسطوانة بالاعتماد على استخدام خياري 
.الاعلى والأسفل  Quadrantعلى امتداد خيار 

:وذلك كالآتي ,نبدأ بتحميل نوع المستقيم ,لرسم الخط المركزي للاسطوانة 3)
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:تحميل نوع الخط 

: Object propertiesالاوسط في شريط   By layerننقر على المثلث الصغير في خيار -أ

By layer → Line type Manager → Load …→ Load or Reload line types       

فننقر على نفس ,فيعود المربع الاول OKثم ننقر ( مثلا  ACADISO04W100) ونختار نوع الخط 
ها وننقر على المثلث الصغير فتظهر القائمة وفي By layerثم نعود الى   OKالنوع المختار ثم على 

.الخيار الجديد لنوع الخط ننقر عليه لكي يدخل قيد الاستخدام في الخطوات اللاحقة 

شكل الجديد نرسم الخط المركزي للاسطوانة بين نقطتي منتصف الخطين العموديين فيتم رسم الخط بال-ب
ن نقطة ابتداءً م,كما يمكن رسم هذا الخط على امتداد مركز الدائرة في المقطع العرض ي .الذي تم اختياره 

.التقاطع مع العمود اليسار الى نقطة التقاطع مع العمود اليمين 

ر لاحق عليهما ويتم رسم التهشير للمقطعين بأمر واحد فيكونان عنصرا واحدا ينفذ أي ام: تهشير المقطعين -ج
.ما بالأخركما يمكن التهشير بتطبيق الامر مرتين فيكونان عنصرين كل على حدة لاعلاقة  لأحده,سوية 

169



 Layersالطبقات :الفصل التاسع 

    التاسعة : الوحدة التدريبية.

          وإجراء التعديلات,إنشائها وتحديد مواصفاتها–الطبقات : الموضوع.

           المهندس نوري موس ى عبد : اسم المعد.

     النظرة الشاملة:

.طلاب الصف الاول : الفئة المستهدفة    -أ

.لانجاز رسم مجموعة متكاملة من الخرائط تغطي كل تفاصيل العمل: مبررات الوحدة   -ب

.انشاء المجموعة الكاملة من الطبقات لانجاز العمل : الفكرة المركزية  -ج

سيكون الطالب قادرا على رسم الطبقات وتحديد مواصفاتها وإجراء: اهداف الوحدة    -د

. التعديلات اللازمة عليها 
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 يستفاد من انشاء الطبقات في : س:

وبمجموعها ,تكوين سلسلة من الطبقات الشفافة تحتوي كل منها على رسم يوضح جزء من فقرات المشروع -أ
.تعطي فكرة كاملة ودقيقة عن العمل 

.اعطاء صورة مشوشة عن العمل -ب

.يوضح كلفة انشاء العمل -ج
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إنشاء الطبقات ومواصفاتها وإجراء التعديلات عليها :الموضوع -

 اف الى ومجموع الطبقات تتضمن معلومات تض,الطبقة عبارة عن ورقة شفافة تتضمن قدر من المعلومات
فاصيل كما انها لاتستدعي تكرار رسم كل ت,بعضها لتكون كاملة وواضحة ودقيقة تغطي كل حاجة العمل 

نشاء الطبقات ويتم تنفيذ ا.الطبقة بشكل كامل وإنما رسم الفقرات الاضافية فقط اختصارا للجهد والوقت 

:الذي يمكن الوصول اليه بإحدى الطرق التالية  Layer properties managerمن مربع الحوار  

.بالنقر على رمز الطبقات  Object propertiesمن شريط  -أ

→ Format  :Formatمن قائمة  -ب layers  .

. enterفي شريط الاوامر ثم النقر على مفتاح  Laبكتابة  -ج

وفي الركن الايمن العلوي توجد مجموعة , 0وتظهر فيه الطبقة الافتراضية ,فيظهر مربع الحوار المذكور اعلاه 
:وهي ,الازرار 

Delete:طبقة بعد تحديدها لحذف          .•New     : يستخدم في انشاء طبقات جديدة.

Show details لإظهار وإخفاء التفاصيل  .•Current: يفعّل الطبقة المختارة بعد تحديدها.

Restore stateاسترجاع  حالة تم حفظها .•Save state  : لحفظ حالة الطبقات.
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كيف يمكن انشاء طبقات بمواصفات محددة ؟: س 

انشاء اربع طبقات بالمواصفات التالية :مثال:

.باللون الاخضر  circleطبقة اسمها 1.

. emptyطبقة اسمها 2.

. 0.5باللون الاحمر وبسمك    lineطبقة اسمها  3.

. 0.5باللون الاصفر وبسمك rectangleطبقة اسمها  4.

:الحل 

فتظهر طبقة جديدة تحت الطبقة , Newننقر على زر ,  ( circle )لإنشاء طبقة جديدة مثل -أ
.layer 1مكان  circleنسمي الطبقة بكتابة ,layer 1في مربع الحوار باسم  0الافتراضية 

.وهو اللون الاخضر لهذه الطبقة colorاما لون الطبقة فيتم اختياره بالنقر على المربع تحت حقل -ب

أو سمك الخط من , line typeكنوع الخط المستخدم من خيار ,وتكملة باقي المواصفات ان وجدت -ج
line weight  كما في طبقةline   وبهذا فأي خط نرسمه في طبقة ) 0.5التي فيها سمك الخط

line  وهكذا يتم انشاء باقي الطبقات ,( وباللون الاحمر0.5سيكون بسمك.
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؟ lineارسم اربعة خطوط كيفما اتفق في طبقة : س 

:الحل 

.فتصبح باللون الازرق أي انه تم تحديدها ,في مربع الحوار  lineننقر على طبقة -أ

على lineفتظهر طبقة OKفتكون هي الطبقة التي يتم العمل فيها ثم  Currentننقر على خيار -ب
.الشاشة 

.  0.5فتظهر باللون الاحمر وبسمك  , نرسم اربعة خطوط -ج

.قد تم تفعيله مسبقا  LWTإلا في حالة ان يكون خيار ,0.5لاتظهر الخطوط اعلاه بسمك : ملاحظة

:يمكن تفعيل أي طبقة من الطبقات بطريقة اخرى وهي :ملاحظة 

هناك مثلث ,( object propertiesفي الجانب الايسر من شريط )في خانة حالة الطبقة -
ننقر ,فاتها بالنقر عليه تظهر قائمة تحتوي على جميع الطبقات المذكورة سابقا مع مواص,صغير

. فتظهر الطبقة بمحتوياتها ,على الطبقة التي يراد اظهارها للعمل فيها 
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:تتمة الاختبار-

 ارسم ثلاثة دوائر وخط في طبقة : مثالcircle  ؟

 الحل:

صباح في طبقة ننقر على رمز الم,تظهر قائمة الطبقات ,بالنقر على المثلث الصغير في خانة حالة الطبقة -أ

circle  تظهر طبقة  ,لتشغيله وإطفاء مصابيح الطبقات الاخرىcircle  على الواجهة.

.فتظهر باللون الاخضر وبالسمك الاعتيادي ,نرسم الدوائر الثلاث والخط -ب

؟ rectangleارسم ثلاثة مستطيلات في طبقة  : مثال •

:الحل 

. rectangleبالطريقة السابقة نختار طبقة  -أ

. 0.5نرسم ثلاثة مستطيلات فتظهر باللون الاحمر وبسمك -ب
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 line, circle, rectangleالشكل كاملا وقد فعلت فيه الطبقات -
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:مسح الطبقات –نقل العناصر •

:نقل العناصر❑

:نقل عنصر مرسوم من طبقة الى طبقة اخرى ❑

. lineالى طبقة  circleنقل الخط المرسوم في طبقة :مثال 

:الحل 

.بالنقر عليه بالماوس  circleنختار الخط المرسوم في الطبقة -أ

الاحمر فيتحول الى اللون ,فيتم نقل الخط الى هذه الطبقة ويكون بمواصفاتها , lineنختار الطبقة -ب
. 0.5وبسمك 

وهناك طبقات لايمكن , deleteيمكن مسح أي طبقة بالنقر عليها ثم النقر على زر :مسح الطبقات❑

والطبقة الحالية  ,والطبقة المرسوم فيها ,DEFPOINTSوطبقة ,0الطبقة الافتراضية : مسحها وهي 
Current layer. ولذلك لايمكن مسح أي طبقة في المثال السابق ماعدا طبقةEmpty  لانها فارغة

. Deleteثم النقر على  Emptyوذلك بالرجوع الى مربع الحوار واختيار طبقة 
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:خصائص الطبقات •
***************

:ها والتي يمكن تغيير ,لكل طبقة العديد من الخصائص مثل اللون والسمك ونوع الخطوط ❑

:وذلك ,يتم تغيير لون دائرة من اللون الاخضر الى اللون الاحمر :تغيير اللون 1)

.فتظهر منقطة ,اختيار الدائرة الخضراء بالنقر عليها -أ

.نفتح قائمة الالوان ونختار اللون الاحمر , Object propertiesمن شريط -ب

.لإلغاء اختيار العناصر ويتحول لون الدائرة الى الاحمر Escنضغط  زر -ج

:تغيير سمك الخطوط 2)

.نختار الخط المعني -أ

(.مثلا1.2)نختار سمك اخر -ب

.فعّال  LWTعندما يكون الخيار  1.2يظهر الخط بسمك , Escنضغط زر -ج

.وقد توضيحه في نهاية الفصل السابق : تغيير نوع الخطوط 3)

,  Thawحيث يمكن اجراء التعديلات عندما تكون ,(مذابة -مجمدة) Freeze/Thawخاصية  4)
. Freezeولايمكن اجرائها عندما تكون  

Onثم النقر خارج القائمة تتحول الى مرئية في حالة,بالنقر على رمز المصباح  On/Offخاصية 5)

. Offوطبقة غير مرئية في حالة  ,
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:تتمة -

ن إلا انه لايمك,والطبقة المقفلة تبقى مرئية ,(عن طريق رمز القفل )  Lock/Unlockخاصية  6)
.اضافة أو حذف منها 

 Don‘tأو لاتطبع على وضع  Plotأي تطبع الطبقة على وضع  Plot/Don‘t plotخاصية  7)

plot,  ويجب الانتباه الى انها لاتطبع اذا كانت على وضعFreeze  حتى لو كانت على وضعPlot.
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:تغيير الخصائص -

:تغيير خصائص عنصر عن خصائص الطبقة التي تحتويه ❑

في القوائم المنسدلة الخاصة باللون  By layerيلاحظ وجود خيار   object propertiesفي شريط  
ائص اما اذا اريد تغيير خص,أي ان العنصر يأخذ خصائص الطبقة تلقائيا ,أو بنوع الخط أو بسمكه 

ر في فيمكن ذلك باختيار خصائص اخرى من هذه القوائم وذلك بتحديد العنص,عنصر تحويه طبقة 

بعد  By layerثم تغيير اللون وعند الرغبة بالعودة الى خصائص الطبقة ننقر على خيار  ,الطبقة 
.النقر على العنصر في الطبقة المفعلة 
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  Blocksالبلوكات :الفصل العاشر 

     العاشرة : الوحدة التدريبية.

            انشاء البلوكات : الموضوع.

            المهندس نوري موس ى عبد : اسم المعد.

      النظرة الشاملة  :

.طلاب الصف الاول : الفئة المستهدفة     -أ

احيانا يتوجب اعادة رسم جزء كبير أو صغير لمرة أو لمرات عديدة مما: مبررات الوحدة    -ب
ر انشاء وتلافيا لذلك وفر البرنامج ام,يستلزم اعادة رسم هذا الجزء ويبذل جهد ووقت اكثر 

.البلوك وحفظه لحين الحاجه اليه 

.كيف يتم انشاء البلوك وطريقة ادراجه وحفظه : الفكرة المركزية   -ج

.  سيكون الطالب قادرا على انشاء بلوك وإدراجه وحفظه :  اهداف الوحدة     -د
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 انشاء البلوكات يؤدي الى : س:

.عدم اعادة الرسم بالتفصيل مرة اخرى -أ

.الرسم في كل مرة بالتفصيل -ب

.الرسم مرة اخرى للحصول على مواصفات متغيرة -ج
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:  الموضوع 

 واسطة  أمر ب)يستخدم البرنامج مايسمى البلوكات لتبسيط عملية الرسم المتكرر في نفس الملف

Make block), أو في ملفات اخرى لاحقة ( بواسطة امرWrite block  ) من دون الحاجة لإعادة
.لوك والبلوك عبارة عن مجموعة من العناصر يتم دمجها سوية لتصبح مايسمى الب, الرسم مرات متكررة

: Make blockانشاء البلوك  ❖

:يتم انشاء البلوك بالطرق التالية 

→ Draw  :Drawمن قائمة  -أ Block → Make .

.( make block )من شريط الرسم بالنقر على الرمز -ب

. enterفي شريط الاوامر ثم النقر على مفتاح bكتابة حرف -ج

. Block Definitionيظهر مربع الحوار 
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: Block Definitionاستخدام المربع -

:نتبع الخطوات التالية لاستخدام المربع اعلاه 

.Nameادخال اسم للبلوك في خانة  1)

نقر على لاختيار العناصر المكونة للبلوك ثم ال,فيتم العودة الى الرسم  Select objectsالنقر على  2)
enter .

ري ان وليس من الضرو ,منها(البلوك)وهي النقطة التي يتم مسك الشكل  Base pointتحديد نقطة  3)
.تكون على عنصر في البلوك 

:تفعيل احد الخيارات التالية 4)

العناصر وفيه يحتفظ كل من,وحفظه في ذاكرة البرنامج حيث يتم تحويل العناصر الى بلوك:  Retain-أ
.المكونة للبلوك بان يكون عنصر لوحده 

وإنما مع عدم الابقاء على العناصر المكونة كل لوحده,تحويل العناصر الى بلوك :  Convert to block-ب
(.أي ان البلوك يصبح عنصرا واحدا ) يكون جزء من البلوك 

.التحويل الى بلوك مع مسح العناصر المكونة من شاشة الرسم :  Delete-ج
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يراد انشاء بلوك منها( مربع ومستقيم,دائرة )في الشكل المجاور ثلاثة عناصر.

:الحل 

ثم نكتب اسم للبلوك ,من شريط الرسم  Make blockنختار 1)

( shape ) مثلا.

يتم اخفاء مربع الحوار ويتم Select objectsالنقر على 2)

.enterاختيار الشكل بفتح نافذة ثم نقر 

تتم , pick pointننقر على ,يعاود مربع الحوار الظهور 3)

( .مركز الدائرة ) Base pointالعودة الى الشكل ونختار 

.OKثم نقر Retainنختار 4)

,وهنا عند اختيار أي عنصر ممكن لانه سيكون منفصل لذاته

لايمكن اختيار عنصر  Convert to blockاما في حالة 

.لوحده لانه سيكون جزء من البلوك ويكون البلوك عنصرا واحدا 
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: Insertادراج البلوكات ❖
************************

يمكن الوصول الى نفس ) Insertيظهر مربع حوار  Drawمن شريط الرموز  Insert blockننقر على -أ
→ Insertالمربع عن طريق قائمة  Block  ), وهو ,  فنختار اسم البلوك الذي تم انشائه سابقا

(shape) من حقلName .

:تظهر فيه الخانات  Insertفي مربع الحوار -ب

(1Insertion points  : وفيه يتم تحديد إحداثيات النقطةBase point .

(2Scale                  : ومنه يتم تحديد مقياس الرسم باتجاهX,Y  .

(3Rotation             : لتحديد زاوية دوران الشكل.

 Specifyاما بواسطة الخيار  ( أي التحديد ) يمكن انجاز الفقرة ,ويلاحظ في الخيارات الثلاثة اعلاه

on screen, وهذا الخيار يعني ان تحديدBase point  أوScale  أوRotation سيتم
داثيات اما عدم تفعيل هذا الخيار فان التحديد يتم عن طريق اختيار إح,بواسطة النقر بالماوس 

X,Y أو معامل التكبير أو زاوية الدوران.

(4Explode          : لتفجير الشكل بحيث يكون كل عنصر منفصل  عن العناصر الاخرى.
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: Write blockحفظ البلوكات ❖
*****************************

:ويحتوي على  Write Blockيظهر مربع حوار , enterفي شريط الاوامر ثم نقر  wblockنكتب 

:من خلال الخيارات Sourceتحديد مصدر البلوك في خانة 1)

. Blockباختيار بلوك تم تعريفه داخل المستند باستخدام امر -أ

. Entire drawingالمستند بأكمله   -ب

.Blockكما تم في امر  Select objectsباستخدام  objectsعناصر -ج

. Blockوباقي الاختيارات كما في امر  Insertion pointتحديد نقطة الادراج 2)

بالضغط على الزر الذي يحتوي على  locationومكان حفظ البلوكات  File nameتحديد اسم البلوك 3)
.ثلاث نقاط  

.تحديد وحدات الرسم 4)
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(  وكبل)ثم حشر الشباك على شكل كتلة ,ارسم الشكل ادناه الذي يمثل غرفة : س 

بعد انشائه ؟                                                  
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:تهيئة الواجهة بابعاد مناسبة ورسم الغرفة والشباك :الحل 

غيرة لذلك يلاحظ ان الشكل يتكون من غرفة وهو ذو ابعاد ص,قبل البدء برسم الغرفة : تغيير ابعاد الواجهة 1)

:وذلك كما يلي (20,10)نغير ابعاد الشاشة الى ما يناسب ابعاد الرسم ونجعلها 

→ Format  :Formatمن قائمة -أ Drawing limits .

. (20,10)ونكتب ركن اعلى اليمين (0,0)نوافق ركن اسفل اليسار -ب

aثم نكتب .enterفي شريط الاوامر ثم النقر على مفتاح zلتأكيد الخيار اعلاه لابعاد الشاشة نكتب -ج

فتكون ابعاد الواجهة قد تحولت الى الابعاد الجديدة , enterفي شريط الاوامر ثم النقر على مفتاح 
(20,10) .

lineكما تعلمنا سابقا بواسطة الامر :  (0.25)للبدء برسم جدران الغرفة بالابعاد المطلوبة وسمك الجدار2)

.فكان الرسم التالي , وأي امر اخر من اوامر التعديل OTRACKلرسم الخطوط وتفعيل خيار 

لرسم Lineوينفذ الرسم باستخدام الامر :  (2,0.25)التي تمثل الشباك بابعاد ( البلوك)لرسم الكتلة 3)
فينتج الشباك , (0.1)على مسافة  Offsetورسم الخطين الداخلين بواسطة الامر ,خطوط المستطيل 

.Aشكل 
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:الغرفة قبل ادراج الشبابيك -
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( :انشاء البلوك) تتمة الحل -

 ( الكتلة)انشاء البلوكMake Block (أي تحويل الشباك الى بلوك):

:وفيه  Block Definitionيظهر مربع الحوار  Make Blockبعد النقر على رمز 

.مثلا  (hwindow)نكتب اسم البلوك (Name)في خانة  1)

.يختفي المربع , pick pointننقر على   Base pointفي الحقل 2)

. البلوك ( ادراج)وتسأل عن نقطة حشر  Specify insertion base point: تظهر الرسالة 3)
.فيعود مربع الحوار للظهور , نختار نقطة منتصف العمود الايسر للمستطيل 

.يختفي المربع مرة اخرى  Select pointننقر على ,  Objectsفي الحقل  4)

ثم النقر , enterثم النقر على مفتاح ,نحدد الشكل بفتح نافذة  Select objectsتظهر الرسالة 5)
.هنا تم انشاء بلوك لرسم الشباك .في مربع الحوار  OKعلى 
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:وادراجه بعد التحكم في مواصفاته , ادراج البلوك كما هو -

 البلوك  ( ادراج)حشرInsertion Block :

. Insertيظهر صندوق الحوار ,(Insert Block)من شريط ادوات الرسم نختار الرمز 1)

ونتأكد من وجود  (hwindow)نبحث عن اسم البلوك الذي تم انشائه في الرسم وهو  Nameفي خانة 2)
. Specify on screenفي خانة  Insertion pointفي حقل ( صح)اشارة 

.يختفي المربع , في المربع  OKننقر على 3)

على نعين نقطة الادراج بالنقر فيها فيحشر البلوك فيها,  Specify insertion point: تظهر الرسالة 4)
.Bكما في .شكله نفسه 

 التحكم بمواصفات البلوك المحشور:

. Insertionكرر تنفيذ الامر 1)

. Specify on screenيجب التأكد من عدم تنشيط  Scaleفي الحقل  2)

.Cكما في .على حالها  Y,Zوإبقاء الابعاد Xلمضاعفة مقياس الرسم باتجاه ,2نكتب Xفي خانة 3)
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:تدوير البلوك وحشره -

  كما في : لتدوير البلوكD.

. Insertكرر تنفيذ الامر 1)

.OKثم النقر على  Specify on screenتأكد من تنشيط   Rotationفي الحقل  2)

كنقطة حشر Dتحديد النقطة العليا في المكان ,  Specify insertion point: تظهر الرسالة 3)
.البلوك 

فيتم. نختار النقطة السفلى في الجدار المائل , Specify rotation angle (0)تظهر الرسالة  4)
.في الجدار المائل( البلوك)حشر الكتلة 

.بنفس الخطوات السابقة , Fيتم حشر الكتلة 5)
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الشكل الاخير بعد تنفيذ كل الخطوات السابقة -
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الطباعة : الفصل الحادي عشر 

    الحادية عشرة : الوحدة التدريبية.

          الطباعة : الموضوع.

           المهندس نوري موس ى عبد :اسم المعد.

     النظرة الشاملة:

.طلاب الصف الاول : الفئة المستهدفة    1)

.لتبيان كافة التفاصيل على الورق : مبررات الوحدة   2)

.الطبع والقيام ببعض الاعدادات قبل الطبع : الفكرة المركزية  3)

.وطبعه ,سيكون الطالب قادرا على تهيئة الرسم للطبع : اهداف الوحدة    4)
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 لنقل مخطط أو رسم ما الى الورق لابد من : س:

.وجود طابعة -أ

.عدم وجود طابعة -ب
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الموضوع 

 الطباعةPrint :
ضر المتصل يمكن التحكم في خصائص العناصر مثل اللون ونوع الخط فمثلا يمكن ان يطبع الخط الاخ

م بخصائص وهناك طريقتين للتحك,كما يمكن ان يطبع بنفس خصائصه ,كخط متقطع باللون الاحمر 
:وهما ,العناصر التي سيتم طباعتها 

وفيه يتم تحديد الخصائص حسب اللون المرغوب  Color depended plot styleبواسطة 1)
ع الخطوط أو طب,للعنصر فمثلا نخبر البرنامج ان يطبع الخطوط الحمراء كخطوط متصلة أو متقطعة 

.الصفراء باللون الاسود ام بنفس اللون وهكذا 

.layerمعين لكل طبقة ( نموذج) Styleوفيه نقوم بتحديد  Named plot styleبواسطة 2)

:Toolsلتحديد الطريقة نستخدم قائمة  3)

Tools → options → plotting                                   

. OKثم نقر  Use color depended plot stylesثم نفعّل الخيار المطلوب  

197



:امر الطباعة -

:لتشغيل امر الطباعة نستخدم احدى الطرق التالية 

→ File  :Fileمن قائمة 1) plot  .

. plotمن شريط الادوات القياس ي بالضغط على رمز الطباعة 2)

.enterفي شريط الاوامر ثم النقر على   plotنكتب 3)

.بنفس الوقت p +Ctrlالضغط على مفتاحي 4)

:ويحتوي على خيارين رئيسين  Plotيظهر مربع الحوار 

.المطلوب  styleويعني تحديد نوع الطابعة والنمط  :   Plot device-أ

.ويختص بطباعة الجزء المطلوب ومقاس الورقة ومقياس الرسم وعدد النسخ : Plot settings-ب

:نتبع الخطوات التالية ,وللتهيئة للطبع 

.A من خيارPlot device:

نقوم باختيار الطابعة المستخدمة في Nameوفي حقل plotter configurationفي الجزء -أ
.الطبع 

:نختار النمط والأنماط انواع Plot style table (pen assignments)في الجزء -ب
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:( style )انواع الانماط -

خصائصهاسم النمط

1-Acad.  Ctb              يطبع كل خط بلونه وسمكه ونوعه.

2-Grayscale.  Ctb       يطبع كل الخطوط بدرجات اللون الرمادي وبسمكه ونوعه.

3-Monochrome.  Ctb  ند لذا يستخدم ع) يطبع كل الخطوط باللون الاسود وبسمكه وبنوعه

(.الرغبة بالطبع باللون الاسود فقط 

4-Screening X%  Ctb  حيثx ويستخدم هذا النمط في طبع المسودات25,50,75,100تمثل

سوف يتم طباعة المسودة screening%25فلو اخترنا ,لتوفير الحبر 

فقط%25بصرف حبر بنسبة 
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:تتمة تهيئة الطبع -

.B من خيارPlot settings:

.نختار مقاس ورقة الطبع  paper sizeمن القائمة -أ

ويستخدمان في  landscapeو  portraitيوجد خيارين هما  Drawing orientationفي -ب
.تحديد اتجاه الرسم بالنسبة للورقة 

:ويحتوي على الخيارات التالية ,يتم تحديد الجزء المراد طباعته  plot areaفي الجزء -ج

الخيار                             معناه 

.1Limits    : يتم طباعة الاشكال التي تقع داخل حدود المستند التي حددت بهذا الامر.

.2Extents  : يتم الطباعة على حدود الرسم ( مثلما هو في خيارZoom. )

.3Display  : يتم طباعة ما معروض على الشاشة حاليا.

.4Window  : وهذا الاختيار هو افضلها حيث بالضغط على زرWindow  يتم العودة الى
.المستند لترسم نافذة على الجزء المطلوب طباعته 

200



:تتمة -

:وهو خاص بتحديد مقياس الطبع وفيه  Plot scaleفي الجزء -د

(1Scaled to fit  ويقوم بتكبير المستند قدر الامكان ليملأ الورقة.

على اليسار وبجواره customلتحديد مقياس السم حيث يوجد مربع Customخيار 2)
. Drawing unitsومربع على يمينه يكتب بجواره , mmالوحدات 

:وفيه يتم تحديد موقع الرسم بالنسبة للورقة حيث يوجد :Plot offsetفي الجزء الاخير -ه

.لوضع الرسم في منتصف الورقة  Center the plotالاختيار 1)

سر لتحديد موقع الركن الايسر الاسفل للرسم بالنسبة للركن الايX,Yكما يمكن استخدام 2)
.الاسفل بالنسبة للورقة 
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الفصل الثاني عشر 

الرسم الكهربائي
      الثانية عشرة : الوحدة التدريبية.

             رسم الدوائر الكهربائية : الموضوع.

             المهندس نوري موس ى عبد : اسم المعد.

       النظرة الشاملة  :

.طلاب الصف الاول : الفئة المستهدفة      -أ

تعنى مجموعة الخرائط لمشروع ما بتوفير معلومات عن كافة اعمال: مبررات الوحدة     -ب
وضح أو انها عمل قائم بذاته مما يستلزم رسم خرائط ت,المشروع ومن ضمنها الكهربائية 

.تفاصيل تلك الاعمال 

.رسم خرائط كهربائية شاملة للتفاصيل الكهربائية : الفكرة المركزية    -ج

.سيكون الطالب قادرا على اتقان رسم الخرائط الكهربائية : اهداف الوحدة      -د
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 لانجاز رسم المخططات الكهربائية : س:

.الرجوع الى برنامج اخر-أ

.امكانية رسم المخططات الكهربائية  Auto CADيوفر برنامج -ب
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الموضوع

الرسم الكهربائي 
كافة فروع  قابلية عالية لرسم كافة الدوائر الكهربائية البسيطة والمعقدة ب (AutoCAD)يوفر برنامج 

:وخرائط التأسيسات الكهربائية جزء منها ,التخصصات الكهربائية 

:رسم الدوائر الكهربائية 

:الرموز الكهربائية •

رف يمكن اظهار الرموز الكهربائية الموجودة في البرنامج عن طريق مربع الحوار الذي يع
AutoCAD2002Today بالطرق التالية ,الذي يظهر على الواجهة:

.في بداية كل تشغيل للبرنامج 1)

→ Tools :Toolsمن قائمة  2) Today .

.standard Toolbarفي شريط الادوات القياس ي  Todayعند النقر على رمز 3)

يلاحظ انه يحتوي على ثلاث خيارات رئيسية ثالثها هو خيار Todayوعند ظهور مربع الحوار 
(Symbol libraries) بمختلف التخصصات وما يخص ( خيار15)ويحتوي على عدة خيارات

 Electricalوالخيار الثالث عشر ,Basic Electronicsالرموز الكهربائية الخيار الخامس  

power, و الرابع عشرAnalog Integrated circuits , والخامس عشرCMOS 

Integrated circuits وعند نقر احدها تظهر رموزه على يسار الواجهة  .
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تتمة -
اظهار الرموز 

ين تابعين أي ان الخيار ,كما ان هناك خيارين اخرين يظهران نفس الرموز التي كانت ظاهرة سابقا ثم اخفيت : ملاحظة 
فان للطرق الثلاث الرئيسية السابقة فلو تم اظهار رموز الخيار الخامس ثم اخفيت بعد انجاز العمل

:هذان الخياران هما ,استخدام أي من الخيارين الفرعين يظهر نفس رموز الخيار الخامس وهكذا 

.بنفس الوقت  Ctrl + 2بالنقر على مفتاح  1)

  standardفي شريط الادوات القياس ي  Auto CAD Design Centerعن طريق الرمز 2)

Toolbar.
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:بناء الدوائر الكهربائية •

مكونة من بطارية , كما في الشكل ,لبناء دائرة كهربائية بسيطة 

وبعد اظهار الرموز ولإدراج المقاومة على الشاشة ,ومقاومة مثلا 

:نتبع الاتي 

.ننقر على رمز المقاومة بالماوس فيتم تحديدها 1)

ننقر على الرمز اعلاه باليمين تظهر قائمة تحتوي على 2)

.Copy  ,Insert Blockخيارين 

وحركة المؤشر الى الواجهة Copyعند النقر على خيار 3)

يظهر,( pasteلصق ) والنقر باليمين تظهر قائمة نختار منها 

ويطلب ( المقاومة ) المؤشر وقد علقت فيه نسخة من العنصر 

   Specify insertion pointتحديد نقطة الادراج بالرسالة 

.فيتم ادراج نسخة من العنصر في المكان بالنقر فيه ,ويمكن ذلك بالنقر بالماوس أو كتابة الاحداثيات 
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اما عند  , لايمكن تغيير مواصفات العنصر بل يدرج كما هو Copyعند استخدام الخيار :ملاحظة 
:يمكن اجراء بعض التغييرات وهي  Insert Blockاستخدام الخيار 

:وفيه  Insertفبعد النقر عليه يظهر مربع حوار باسم , Insert Blockعند استخدام الخيار ➢

أي انه ) Nameيظهر مكتوبا في خانة ( في هذا السؤال Resistorالمقاومة ) اسم العنصر المختار -أ
( .قد تم اختياره للإدراج على الواجهة في الخطوة اللاحقة 

:هما ,يمكن تحديد طريقة ادراج العنصر من احد خيارين  Insertion pointفي حقل -ب

ة ويترك اختيار نقط,تظهر علامة صح ,بالنقر في المربع Specify on-screenاذا تم تفعيل خيار ✓
.الادراج للماوس 

دراج بواسطة ويحدد مكان نقطة الا ,تختفي علامة الصح (بالنقر في المربع مرة ثانية ) وإذا الغي تفعيله ✓

.X,Y,Zكتابة احداثياتها في الخانات  

بواسطة ( ب)بنفس طريقة الفقرة Scaleيمكن اختيار معامل تكبير أو تصغير العنصر في حقل  -ج
.(X,Y,Z)أو تحديد المعامل بالكتابة في المكان المناسب ,الماوس 

يارين في كما يمكن اختيار زاوية دوران العنصر في الواجهة بالنسبة الى شكل الرمز ويتم بنفس الخ-د

. أي بواسطة الماوس أو بكتابة  قيمة الزاوية (  ج)أو ( ب)الفقرة 
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:تتمة -

يجب ان ( البطارية)فقط نلاحظ ان شكل العنصر,لإدراج رمز البطارية نتبع نفس الخطوات السابقة 4)
ك يجب ان لذل, بينما في الرموز تكون البطارية افقية ( الرسم ) يكون عمودي في الدائرة الكهربائية 

في الواجهة ويصبح ( البطارية ) فيدور رمز العنصر 0بدلا من  Rotationفي خانة 90نكتب زاوية 
فيغلق المربع ويدرج رمز البطارية في OKننقر على , Insertوبعد اتمام الخيارات في مربع  . عموديا 

.المكان الذي تم تحديده فيما سبق 

.وحسب شكل الدائرة  Lineنوصل العناصر بخطوط بواسطة الامر 5)
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◙أو لإدراج رمز جديد ,في حالة عدم توفر الرمز ◙

مر نرسم رمزا جديدا يمثل العنصر كما تعلمنا في اوا,عند عدم وجود رمز لعنصر مطلوب ادراجه ضمن الدائرة 6)

Draw وModify  الاميتر ) يار فلرسم رمز يمثل مقياس الت, ( أو في أي مكان ثم نقله ) نرسمه في المكان المطلوب
:مثلا وهو غير موجود ضمن الرموز المتوفرة نتبع ( 

.A من قائمةDraw  نختار امر دائرةCircle  ونرسم دائرة بأبعاد مناسبة لرمز.

.B من قائمةDraw  نختار امر كتابةText    لكتابة حرفA فيرسم الرمز  المطلوب ليمثل جهاز ,في داخل الدائرة
.قياس التيار 

.C فترسم .ريقة ولا ضير في اتباع أي ط,قد تتوفر اكثر من طريقة لرسم الرمز من خلال اوامر قائمتي الرسم والتعديل

:الدائرة بالشكل التالي 
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خواص الثنائي –ارسم الدائرة 
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